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1. Introduction 

 
The examples in this manual can be made in a full licensed as well as in a tryout or student version of 
SCIA Engineer. 
 
Here follows an overview of the required SCIA Engineer modules / editions, per subject: 
 

 
- Eigen frequency calculations 
esas.21 (Dynamics (natural frequencies) - Frames)   Professional edition 
esas.22 (Dynamics (natural frequencies) - Surfaces)   Professional edition 
 
- Advanced dynamic calculations 
esas.23 (Dynamics (advanced) - Frames)    Professional edition 
esas.24 (Dynamics (advanced) - Surfaces)    Professional edition 
 
- Non uniform damping characteristics 
esas.25 (Non uniform damping - Frames)    Not part of an edition 
 

 
 
Dynamic calculations are not so frequent in civil engineering as static calculations. On the other hand, 
they are inevitable in certain projects. Wind effects on high-rise structures, transverse vibration of 
towers and chimneys, structures located in seismic regions,…  
SCIA Engineer contains specialized modules covering common dynamics-related issues. In this 
course, the different aspects of these modules are regarded in detail. 
First, the foundation of dynamic calculations is examined: the eigen frequency calculation. Eigen 
frequencies form the basis for all types of dynamic analysis. 
In the third chapter the eigen frequency calculation is extended with harmonic loads: the influence of 
for example vibrations due to machinery, can be calculated using these principles. 
Two chapters are devoted to seismic calculations and the influence of damping on the seismic action. 
The final chapter of the course discusses the aspects of Vortex Shedding, used for example to 
calculate chimneys. 
 
All chapters are illustrated with examples. The relatively easy examples have been purposefully 
chosen to provide a clear understanding of what actually happens in the dynamic calculations. To this 
end, nearly all calculations have been verified by manual calculations to give a good insight into the 
application of the theory in SCIA Engineer. 
When the principles are clearly understood, they can be applied to more complex structures without 
difficulties. 
 
The project files can be found on the accompanying CD and have been divided into two groups: 
- Initial Projects: The project files without the dynamic input, used throughout the course. 
- Final Projects: The project files completed with the dynamic calculations, thus representing the final 
results at the end of the course. 
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2. Free Vibration: Eigen Frequencies 

 
In this chapter, the calculation of eigen frequencies in SCIA Engineer is explained in detail.  
Eigen frequencies can be required to verify comfort criteria for buildings, to analyze wind-
induced resonance for bridges, to check requirements for sensitive equipment,… 
First, the theory behind the calculation is discussed and illustrated with an example. The 
procedure is then used for both frame and slab structures. The results of all examples are 
compared with manual calculations to provide a clear understanding of the applied principles. 
 

2.1 Theory 

To understand what is going on during the dynamic analysis of a complex structure with frames 
or finite elements, the free vibration of a SDOF (Single Degree Of Freedom) system is regarded 
in detail. A complete overview can be found in reference [1]. 
 
Consider the following system: 

 
 
A body of mass m is free to move in one direction. A spring of constant stiffness k, which is fixed 
at one end, is attached at the other end to the body. 
The equation of motion can be written as: 

0)()( 


tyktym       (2.1) 

A solution for this differential equation is: )cos()( twAty   

Inserting this in (2.1) gives: 

0)cos()( 2  tAkm      (2.2) 

This implies that: 

m

k
        (2.3) 

Where   is called the natural circular frequency. 

The natural period T can be written as: 



2
T        (2.4) 

The natural frequency (or eigen frequency) f can be written as: 





2

1


T
f       (2.5) 

For a general, MDOF (Multiple Degree Of Freedom) structure, equation (2.1) can be written in 
matrix notation: 

0


UKUM       (2.6) 
 
 
Where:      U is the vector of translations and rotations in nodes, 
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U is the vector of corresponding accelerations, 

K is the stiffness matrix assembled for the static calculation, 
M is the mass matrix assembled during the dynamic calculation. 

From this equation it is clear that the calculation model created for a static analysis needs to be 
completed with additional data: masses.  
The solutions of (2.6) are harmonic functions in time. A possible solution can have the following 
form: 

 )(sin 0TTU        (2.7) 

Notice that in this solution a separation of variables is obtained: 

- The first part, ( ), is a function of spatial co-ordinates, 

- The second part,  )(sin 0TT  , is a function of time. 

When substituting (2.7) in (2.6), an equation is obtained which is known as the Generalized 
Eigenproblem Equation: 

02  MK       (2.8) 

The solution of (2.8) yields as many eigenmodes as there are equations. 
Each eigenmode consists of 2 parts: 

- An eigenvalue:  value i  

- An eigenvector:  vector i , which is not fully determined.  The deformation 

shape is known, but the scale factor is unknown. 
This scale factor can be chosen in different ways. In the next paragraph this will be explained 
further. 
 
An overview of the mathematical (matrix) approach behind the calculation of eigenvalues and 
eigenvectors can be found in reference [25]. 
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2.2 Eigen Frequencies in SCIA Engineer 

In SCIA Engineer, as scale factor, a M-orthonormalisation has been implemented. This is 
shown in the following relation: 

1 i

T

i M       (2.9) 

Some of the characteristics of M-orthonormalisation are: 

0 i

T

j M , When ji       (2.10) 

2

ii

T

i K        (2.11) 

The M-matrix (the mass matrix) can be computed in different ways. SCIA Engineer uses the so-
called lumped mass matrix representation of the M-matrix. The lumped mass matrix offers 
considerable advantages with respect to memory use and computational effort because in this 
case the M-matrix is a diagonal matrix. The masses are thus guided to the nodes of the Finite 
Element mesh.  
This principle is illustrated on the following figure [28]: 

 
The calculation of eigenmodes and eigen frequencies is thus made on a discretised finite 
element model of the structure. This means that instead of a general structure with an infinite 
number of degrees of freedom, a calculation model with a finite number of degrees of 
freedom is analyzed.  
The number of degrees of freedom can generally be determined by a simple multiplication: the 
number of mesh nodes is multiplied by the number of possible displacements in the node.  
 
It is important to know that the accuracy of the model is in proportion to the "precision of 
discretisation", i.e. to the number of elements of the finite element mesh. This refinement has 
almost no practical meaning in static calculations. However, for dynamic and non-linear 
analyses, it significantly affects the accuracy of the results. 
 
Consider the following example. A beam on two supports is loaded by its self-weight. By default 
(for a static calculation) there is only one finite element for the beam. Taking the above into 
account, the mass M of the beam will be guided to the two end nodes of the beam since these 
correspond with the mesh nodes of the finite element mesh. 

 
In this case, this means that the entire mass will be located in the supports so no mass can go 
into vibration and the dynamic calculation cannot be executed. As indicated, a mesh refinement 
is required here to attain results. 
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The following diagram shows the required steps to perform a Free Vibration calculation: 
 
 

 
 
The analogy between a static and dynamic calculation is clear:  

- In a static calculation, Loads are grouped in Load cases and the Load cases are used in 
Combinations. 

- In a dynamic calculation Masses are grouped in Mass Groups and the Mass Groups are 
used in Mass Combinations. 

 
The required steps from this diagram are illustrated in the following example. 

  

 Activate the Dynamics functionality 

Input Masses Generate Masses from Static Load cases 

Create a Mass Group 

Create a Mass Combination 

Perform a Free Vibration Calculation 

Refine the Finite-Element Mesh if required 

Specify the number of Eigenmodes to be calculated 
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Example 2-1: Free_Vibration_1.esa 

In this example, a beam on two supports is modeled. The beam has a cross-section type IPE 
200, a length of 6m and is manufactured in S235 according to EC-EN. A node has been added 
to the middle of the beam, which will make it possible to add a nodal mass in that location. 

 
Only one static load case is created: the self weight of the beam. 
 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionality Dynamics on the 
Functionality tab in the Project Data. 

 
 
When this is done, a new group will appear in the Main menu: 
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Step 2: Mass group 

The second step is to create a Mass Group. 

 
 
As indicated in the diagram, a Mass Group is used to group masses in a same way a Load Case 
is used to group Loads. When a Mass Group is defined, masses can be inputted.  
SCIA Engineer also allows the user to create masses from a static load case.  
 
When for example a roof weight is inputted as line loads, the action “Create masses from load 
case” will automatically generate masses from these line loads. It is clear that this provides a 
quick input of necessary data. When the option “Keep masses up-to-data with loads” is ticked 
on, then the action to create masses will create masses which remain linked to the loads of the 
load case. The amount of mass in a ‘linked’ mass is updated each time you click on the action 
button “Create masses from load case” or each time you perform a calculation. 

 

Note: 

- The self-weight of a structure is always taken into account automatically for a dynamic calculation. 

Even if there is no mass group linked to self weight. The mass of the self-weight is not displayed.  

- When specifying a load case but not using the action ‘Create masses from load case’ nothing will 

happen: no masses will be created. 

- When creating masses from loads, SCIA Engineer will use the acceleration of gravity specified on the 

Loads tab of the Project Data. By default this value is 9,81 m/s². 

- The mass is generated only from vertical force components. 

- Free loads cannot be converted into masses. 

 

Step 3: Masses 

When Mass Groups are created, Masses can be inputted on the structure. SCIA Engineer 
allows the input of  

- Mass in node 

- Point mass on beam 

- Line mass on beam 

- Surface mass 

- Line mass on surface edge 

- Point mass on surface edge 
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For 1D members:    For 2D members: 

   
 

In this example, a mass of 500 kg will be inputted on the middle node of the beam using Mass 
in node. 
 

 
 
The parameters Koeff mx, Koeff my and Koeff mz specify how much of the mass will 
participate in the vibration according to the global X, Y or Z axis.  
This can be used when calculating for example a chimney: when Koeff mx is put on 1 and Koeff 
my and Koeff mz are taken 0, then the mass can only vibrate in the global X-direction so only 
eigenmodes in that direction will be obtained. 
Imx, Imy and Imz specify the moment of inertia around the global X, Y or Z axis. By default a 
nodal mass is concentrated so it has no inertia. When the mass represents a large machine, it is 
possible to input the moment of inertia of this machine. 
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         The nodal mass of 500 kg is inputted on the middle node of the beam: 

 

Note: 

- To display masses and mass labels, go to Set View Parameters For All > Loads/Masses. 

- Masses are Additional Data, which can be moved/copied to other entities. 

 
 

Step 4: Mass matrix 

Next, the Mass groups can be combined within a Combination of Mass Groups. 
This is actually the mass matrix M which has been mentioned in the beginning of this chapter. 
 

 
 
The Combination of Mass Groups works in the same way as a linear Load Combination. 
A multiplication coefficient can be inputted for each Mass Group. This coefficient can be used 
when the mass of a structure changes during its lifetime. Consider for example a water tank. 
One Combination of Mass Groups can be created with a coefficient 1,00 to specify a full tank 
and another Combination of Mass Groups can be created with a coefficient 0,50 to specify a 
tank, which is half-full. In this way, both cases can be calculated in one time. As stated in step 2: 
the self-weight is automatically taken into account for each Combination of Mass Groups. 
 

Step 5: Mesh setup 

After executing the previous steps, the calculation can already be started. However, as stated in 
2.2 it can be required to refine the Finite Element mesh. 
This can be done through Calculation, Mesh > Mesh Setup. 
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For 1D members (beams) the Average number of tiles of 1D element can be augmented. In 
general, 5 to 10 tiles are sufficient for a dynamic calculation. When specifying a too high amount, 
the calculation will take a long time to complete. For 2D elements (plates & shells) the Average 
size of 2D element needs to be altered. 
 
In this example, due to the inserting of the middle node, 
 there is already a mesh node there, so it is not required 
 to have a denser Finite Element Mesh.  

This can be seen after mesh generation  
 
 
 
 
 
 
 
The created mesh elements and mesh nodes are shown with their number: 

 

Note: 

- To display the numbering of finite elements: 

     1. Go to Set View Parameters For All > Structure > Mesh and tick Draw mesh on.  

     2. Go to Set View Parameters For All > Labels > Mesh and tick Display Label & Elements 1D on. 
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Step 6: Solver Setup 

Another important step before launching the calculation is to specify the amount of eigenmodes 
that need to be calculated and with which method they can be calculated.  
This can be done through Calculation, Mesh > Solver Setup. 
 

 
 
By default, the Lanczos method is used. This method is set as default even in older projects 
where originally another method was used. In comparison with older methods, the Lanczos 
method is faster and more stable.  
 
As explained above, the number of eigen frequencies is dependent of the number of degrees of 
freedom of the structure which are on their turn dependent of the discretisation. 
In this example, only the mesh node located in the middle of the beam can vibrate vertically. 
Therefore only one eigenmode needs to be calculated. The Number of Frequencies can thus 
be lowered to 1. 

 
The options “Use IRS (Improved Reduced System) method” requires floors to be defined first, so 
this option cannot be used now. “Produce wall eigenmode results (needed for ECtools)” is only 
used if you are using the extra program ECtools to analyse seismic effects in masonry. 

 

Note: 

When the number of frequencies is higher than the amount of degrees of freedom, a message will 

appear during the calculation, stating the calculation cannot be executed. The solution is to lower the 

number of frequencies to be calculated or to apply a mesh refinement so more degrees of freedom are 

created. 
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Step 7: Modal Analysis 

The last step is to perform the Modal Analysis calculation through  
Calculation, Mesh > Calculation. 
 

 
 

 
After performing the calculation, the Results menu shows the option Dynamics Eigen 
Frequencies: 
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The preview shows the following result: 
 

 
 
According to this calculation, the natural frequency of the first mode is shown to be 6,31 Hz.  
 
 

Step 8: Calculation protocol 

 
To view the results in more detail, it is possible to look at the Calculation Protocol for the Eigen 
Frequency calculation: 
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Now we will go more in detail about the results in the calculation protocol: 

 

Solution of the Free Vibration: 

- The model was divided in 2 finite elements, resulting in 3 mesh nodes. 

- Each node has a 6 degrees of freedom (X, Y, Z, Rx, Ry, Rz) resulting in 18 equations. 

- The combination of mass groups for the results was CM1. 

- The number of frequencies set in the solver settings is 1. 

- The Lanczos method was used to perform this calculation. 

Sum of masses 

The Sum of masses shows the amount of mass, which can vibrate for this Combination of Mass 
Groups (CM1). In this example, this is governed by the mass of 500 kg and the mass of the 
beam. 
 
The mass of the beam can be calculated as follows:  

- The beam is an IPE 200 with cross-section A= 0,00285 m² 
- The length of the beam is 6 m 
- The volumetric mass of S235 is 7850 kg/m³ 

                
  

  
        

  

 
 

 
Now to find the total mass, we must assign the masses to the mesh nodes and take into account 
the vibrations which are possible:  

- For node 1:                
  

 
             

(¼ of the beam mass goes to the left node) 
 

- For node 2:               
  

 
                                     

(½ of the beam mass goes to the middle node along with the nodal mass in the node) 
 

- For node 3:                
  

 
             

(¼ of the beam mass goes to the right node) 
 

 
 

 X-direction Y-direction Z-direction 

Node 1 Fixed (Frame XZ) Fixed 

Node 2             (Frame XZ)             

Node 3             (Frame XZ) Fixed 

TOTAL               X             

Calc. Protocol                          

 
As you can see, the sum of masses in the calculation protocol corresponds to the sum of 
masses in all mesh nodes, taking into account the degrees of freedom in each node. 
 
It is clear that a denser mesh will provide a more accurate participation of the beam mass. 
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Modal Participation Factors 

 
The Modal Participation Factors show the amount of mass that is vibrating in a specific 
eigenmode as a percentage of the total mass. In this example Wzi/Wztot is equal to 1 which 
means that 100% of the mass is vibrating in the vertical direction for the first eigenmode. This 
means that in the other degrees of freedom, no mass will be displaced in the Z-direction. 
 
The Wyi_R/Wytot_R is equal to 1 means that this first eigenmode the only eigenmode in which 
mass can rotate around the global Y-axis. 
 
As a side note, we must indicate that these results will strongly alter once we use a finer mesh. 
Since more nodes will add more degrees of freedom and thus more possible eigenmodes. 
These factors will be looked upon in more detail during the Seismic calculations. 
 
 
 
Step 9: In this step we will check the eigenmodes 
 
The eigenmode can be visualized through Displacement of Nodes. 

  
 
- Selection is set to All 
- Type of loads is set to Mass Combinations 
- For each eigenmode a specific Mass combination can now be chosen. 
- The Values field is set to Deformed Mesh so the deformation of the mesh nodes is shown. 
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The result is as expected, the inner node is vibrating. A denser mesh will provide a much better 
representation of the Eigenmode. It is important to bear in mind that a vibration is in two 
directions: in this case the eigenmode is shown moving up, however half a period later it will be 
moving down. 
 
Free vibration gives only the conception of structure properties and allows predicting the 
behavior of the structure under time varying load conditions. In nature, each body prefers to 
remain in a standstill. If forced to move, it prefers the way requiring minimal energy consumption. 
These ways of motion are the eigenmodes.  
 
The eigenmodes do not represent the actual deformation of the structure. They only show 
deformation that is "natural" for the structure. This is why the magnitudes of calculated 
displacements are dimensionless numbers. The numbers provided are orthonormed, i.e. they 
have a particular relation to the masses in the structure. The absolute value of the individual 
numbers is not important. What matters is their mutual proportion. 

 
 

The vibration of the structure can be shown through View > New Animation Window. 
 

 
 
Activating the option ‘Preset minimal ratio to invert MAX’ will show the actual vibration in both 
directions. 
 

Note: 

Using CTRL+Right mouse button, the structure can be rotated in the Animation Window. 

 

  



Advanced Professional Training - Dynamics 

22 

Manual Calculation 

In order to check the results of SCIA Engineer, the eigen frequency of this structure is calculated 
by a manual calculation. 
Following reference [1], the circular frequency of a beam on two supports with a mass in the 
middle can be calculated as follows: 

3

2 48
ML

EI
        (2.7) 

With: 

     = Circular frequency 
 E = Modulus of Young 
 I = Moment of inertia of the beam 
 L = Length of the beam 
 M = Mass in the middle of the beam 
 
 

In this example E = 210.000 N/mm² 
  Iy = 19430000 mm

4
 

  L = 6000 mm 
  M = 500 kg 

 
2

2

3

4

2 47,1813
6000500

19430000
²

000.210
48

s
rad

mmkg

mm
mm

N





  

s
rad58,42  






2
f 6,78 Hz 

 
The result calculated by SCIA Engineer was 6,31 Hz. 
The difference in results is caused by two assumptions in the manual calculation: 
 

- The manual calculation does not take into account the self-weight of the beam 

Since 
m

k
    a lower mass will lead to a higher  and a higher f. 

 
- The manual calculation does not take into account shear deformation 

A lower deformation leads to a higher stiffness k, a higher  and a higher f. 
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These two assumptions can also be implemented in the calculation model of SCIA Engineer: 
- In order not to take the self-weight into account, the volumetric mass of S235 can be set 

to 1 kg/m³ in the Material Library: 
 

 

 
 

- To neglect the shear deformation, activate this option through Calculation, Mesh > 
Solver Setup: 
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To obtain a correct and precise result, the mesh must also be refined. By refining the mesh to 10 
finite elements. This can be done through Calculation, Mesh > Mesh Setup: 
 

 
 

Now when the calculation is performed again, the following results are obtained: 

 
 
 
These results correspond exactly to the manual calculation. 
This example clearly shows the importance of checking the assumptions behind the applied 
theories. When comparing results between two calculations, always make sure the same 
assumptions/hypotheses are used. 
 

 

  



Free Vibration: Eigen Frequencies 

25 

2.3 Frames 

In this paragraph, the Free Vibration calculation is illustrated for frame structures. The principles 
of the theory are applied in detail and verified by means of manual calculations. 
 

Example 2-2: Free_Vibration_2.esa 

In this example a two-storey frame is modeled.  
The members have cross-section HEA 240 and are 
manufactured in S235 according to EC-EN.  
 
The height of each storey is 4m.  
The width of the frame is 5m.  
The column bases are inputted as fixed supports. 
 
One static load case is created: self-weight.  
 
On the beams of the floor and roof level, a line mass of 
500 kg/m will be introduced.  
 
 
 
 
 
 
 

Step 1: Mass group 

The activation of the Dynamics Functionality and the creation of a Mass Group are identical to 
the previous example. 
 

Step 2: Masses 

When the Mass Group is created, the line masses of 500 kg/m can be inputted on the roof and 
floor beams of the frame. 
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Note: 

To render the display of masses, go to Set View Parameters For All > Miscellaneous > Drawing style 

for Model + Loads  

 

Step 3: Mass matrix 

 Next, a Combination of Mass Groups can be created. 
 

 
 

Step 4: Mesh setup 

To obtain precise results for the dynamics calculation, the Finite Element Mesh is refined. 
This can be done through Calculation, Mesh > Mesh Setup. 
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The Average number of tiles of 1D element is set to 10 to obtain a good distribution of the line 
masses and the mass of the members. 
 

Step 5: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be 
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this 
example. 
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Step 6: Modal analysis 

The Free Vibration calculation can now be executed through Calculation, Mesh > Calculation. 
The following results are obtained: 
 

 
 
As stated in the previous example, using Deformation of Nodes, the Deformed Mesh can be 
shown to view the eigenmodes: 
 

     
 
Eigenmode 1: f = 2,89 Hz     Eigenmode 2: f = 9,52 Hz 
 

     
 
Eigenmode 3: f = 14,51 Hz    Eigenmode 4: f = 16,94 Hz 
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The Calculation Protocol for the Eigen Frequency calculation shows the following: 
 

 
 
The Sum of masses shows the amount of mass, which can vibrate for this Mass combination. In 
this example, this is governed by the line masses of 500 kg/m and the mass of the members. 

This value can be calculated as follows:  
- The members are of type HEA 240 with cross-section A= 0,00768 m² 
- The volumetric mass of S235 is 7850 kg/m³ 
- The total length of the members is 4 x 4m + 2 x 5m = 26m 

 
However, as stated in 2.2 the masses are guided to the mesh nodes. The Finite Element Mesh 
was refined to 10 1D elements per member. 
This implies that for the two lower columns, half the mass of a 1D element is guided to a support 
and does not take part in the free vibration. 

- The length of the columns is 4m  
- The length of a 1D element is 4m / 10 = 0,4m 
- The length of half a 1D element is 0,4m / 2 = 0,2m 

 The total length of the members taken into account for the mass is  
26m – 0,2m – 0,2m = 25,6m 

 Total member mass = 0,00768 m² x 25,6 m x 7850 kg/m³ = 1543,37 kg 
This mass is added to the line masses of 500 kg/m 

 Vibrating Mass = 2 x 500 kg/m x 5m + 1543,37 kg = 6543,37 kg 
 
The Modal Participation Factors show the amount of mass that is vibrating in a specific 
eigenmode as a percentage of the total mass.  

- For Eigenmode 1: 86% of the total mass is vibrating in the X-direction 

- For Eigenmode 2: 11% of the total mass is vibrating in the X-direction 

- For Eigenmode 3: 16% of the total mass is vibrating in the Z-direction 

- For Eigenmode 4: 54% of the total mass is vibrating in the Z-direction 
 
The lower row shows the total percentage when these four modes are combined: 97% is taken 
into account for the X-direction and 69% for the Z-direction. 
 
These factors will be looked upon in more detail during the Seismic calculations in Chapter 4. 
For a seismic calculation, it is required that sufficient eigenmodes are included in the calculation 
so that at least 90% of the total mass is being taken into account [7]. 
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Manual Calculation 

In order to check the results of SCIA Engineer, the lowest eigen frequency, or natural frequency 
of this structure is calculated by a manual calculation.  
The method used here is described in the literature as Rayleigh’s Energy Method. [1], [13]. 
In this method, the structure is idealized as a cantilever beam with lumped masses at each floor 
level: 

 

The structure is then loaded with a set of linearly increasing horizontal loads on each floor 
level. Due to this loading, the structure will deform and thus the rigidity of the system is known. 
The eigen frequency of the structure can then be approximately calculated as follows: 














n

i

ii

n

i

ii

dM

dF

f

1

2

1

2

1


      (2.8) 

 
With:  
    n = Number of floors 

  Fi = Horizontal force acting on floor level i 
  di = Horizontal deformation of floor level i  
  Mi = Idealized mass of floor level i 

The analogy between this formula and 
m

k
  can clearly be seen. 
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To use this formula, the frame needs to be idealized to a cantilever: 

     
 
The mass of the lower part of the structure is idealized to the support of the cantilever so it takes 
no part in the vibration. 
The mass M1 can be calculated as follows: 

0,00768 m² x (5 + 4 + 4) m x 7850 kg/m³ + 500 kg/m x 5m = 3283,74 kg 
The mass M2 can be calculated as follows: 

0,00768 m² x (5 + 4) m x 7850 kg/m³ + 500 kg/m x 5m = 3042,59 kg 
 
 
In order to calculate the horizontal deformations di of each floor level due to a linearly increasing 
load Fi, a static load case is calculated with SCIA Engineer consisting of loads of 100 kN and 
200 kN. The following results are obtained for the nodal deformations: 
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 F1 = 100 kN = 100000 N 
 F2 = 200 kN = 200000 N 
 d1 = 95,79 mm = 0,09579 m  
 d2 = 199,58 mm = 0,19958 m 

 
 
Applying formula (2.8): 

   







22
19958,059,304209579,074,3283

19958,020000009579,0100000

2

1

mkgmkg

mNmN
f


2,88 Hz 

 
 
This result corresponds to the 2,89 Hz calculated by SCIA Engineer. 
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2.4 Combining mass groups 

Mass Groups are combined in a Combination of Mass Groups. 
According to Eurocode 8 [7] article 3.2.4, all gravity loads appearing in the following combination 
of actions need to be taken into account for an eigenmode calculation: 

   ikiEk QG ,,       (2.9) 

 
Where:  Gk = Characteristic value of the permanent load 
  Qk,i = Characteristic value of the variable load i 

  E,i = Combination coefficient for load i i,2   

 

The combination coefficient E,i takes into account the likelihood of the variable loads not being 
present over the entire structure during the occurrence of an earthquake. 
 

Eurocode 8 [7] indicates that      should be calculated in the following way: 

 

 
 
For example, if a first mass group MG1 represents the mass of permanent loads and a second 
mass group MG2 represents the mass of a variable load case with a Category B imposed load 

and independently occupied storeys, then  is taken as 0,5 and 2,i as 0,3.  

This gives a value of 0,15 for     . 
The Combination of Mass Groups CM1 can then be formulated as 1,00 MG1 + 0,15 MG2. 
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Example 2-3: Free_Vibration_3.esa 

In this example an office building is modeled as a frame. The office is manufactured in C30/37 
according to EC-EN. The building has four storeys with a storey height of 4m. In horizontal 
direction, the frame is made up of four columns with a distance of 6m between them. In the 
direction out of plane, the frames are spaced 5m. The column bases are inputted as fixed 
supports. 
The members of the frame have following cross-sections: 

- Columns: Rectangular 300 x 450 
- Floor Beams: Rectangular 250 x 500 
- Roof Beams: Rectangular 150 x 300 

The vertical loads acting on the structure are: 
- The self-weight of the concrete members 
- The weight of the floors: 5 kN/m² 
- The weight of the roof: 2 kN/m² 
- A category B (Office) imposed load of 3 kN/m² 

 
 
This gives 3 static Load-Cases: 
LC1: Self-Weight 
LC2: Permanent Load: 25 kN/m on the floor beams, 10 kN/m on the roof beams 
LC3: Variable Load: 15 kN/m on the floor beams 
 

 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionality Dynamics on the 
Functionality tab in the Project Data. 
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Step 2: Mass groups 

The second step is to create Mass Groups, the third step the creation of Masses. 
Since the self-weight is automatically taken into account in a Combination of Mass Groups, 
two Mass Groups are created here, one for each Static load case. 
 
For the Mass Group MG1, the load case LC2 is chosen: the weight of the floors and roof. Using 
the option “Keep masses up-to-date with loads” and then the action “Create masses from 
load case” automatically generates masses from the already inputted loads which remain linked 
to the loads. 
 

 
 
In the same way, the Mass Group MG2 is created in which masses are automatically created 
from load case LC3: the imposed load. 

 

 
 
 

Note: 

 

- As stated in the first example: When creating masses from loads, SCIA Engineer will use the 

acceleration of gravity specified on the Loads tab of the Project Data. By default it is 9,81 m/s². 

 

- In versions previous to SCIA Engineer 2013, the mass will always remain unchanged after any 

modification or removal of the original force. If the mass is supposed to correspond to the modified 

force, it is necessary to remove the mass and to create it once more. 
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Step 3: Masses 

In the Masses menu, the contents of both Mass Groups can be visualized. 
- Mass Group MG1: 

 
 

Floor mass: 
m

kg

s
m

m
N

4,2548
81,9

25000

2

  

Roof mass: 
m

kg

s
m

m
N

4,1019
81,9

10000

2

  

 
- Mass Group MG2: 

 

Mass of imposed load: 
m

kg

s
m

m
N

1,1529
81,9

15000

2
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Step 4: Mass matrix 

Both Mass Groups can now be combined in a Combination of Mass Groups. 
According to Eurocode 8 [7] article 3.2.4, all gravity loads appearing in the following combination 
of actions need to be taken into account for an eigenmode calculation: 

   ikiEk QG ,,       (2.9) 

 

For this example, with a Category B imposed load and independently occupied storeys,  is 

taken as 0,5 and 2,i as 0,3. This gives a value of 0,15 for     . 

 

The Combination of Mass Groups CM1 can then be formulated as 1,00 MG1 + 0,15 MG2. 
 

 
 

Step 5: Mesh setup 

To obtain precise results for the dynamics calculation, the Finite Element Mesh is refined. This 
can be done through Calculation, Mesh > Mesh Setup. 

 
 
The Average number of tiles of 1D element is set to 10 to obtain a good distribution of the line 
masses and the mass of the members. 
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Step 6: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be 
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this 
example. 
 

 
 

Step 7: Calculation 

The Free Vibration calculation can now be executed through Calculation, Mesh > Calculation. 
 
The following results are obtained: 
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With corresponding Eigenmodes: 
 

   
Eigenmode 1: f = 1,28 Hz     Eigenmode 2: f = 3,70 Hz 

 

   
 
Eigenmode 3: f = 6,01 Hz     Eigenmode 4: f = 8,26 Hz 
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The Calculation Protocol for the Eigen Frequency calculation shows the following: 
 

 
 
 
The Sum of masses can be calculated as follows: 
 

- According to the Bill of Material, the self-weight of the frame is 40500 kg. 

 
 
However, for the four lower columns, half the mass of a 1D element is guided to a support and 
does not take part in the free vibration. 

- The length of the columns is 4m  
- Since 10 1D elements per member were used, the length of a 1D element is 4m / 10 = 

0,4m 
- The length of half a 1D element is 0,4m / 2 = 0,2m 
- The columns have a cross-section of 0,135 m² and a volumetric mass of 2500 kg/m³ 

 The mass of the columns not taken into account is:  
 
4 x 0,135 m² x 0,2 m x 2500 kg/m³ = 270 kg 

 The mass of the self-weight taken into account is: 40500 kg - 270 kg = 40230 kg 
- For MG1 the mass of the floors is 9 x 2548,42 kg/m x 6m = 137614,68 kg 

- For MG1 the mass of the roof is 3 x 1019,37 kg/m x 6m = 18348,66 kg 

- For MG2 the mass of the imposed load is 9 x 1529,05 kg/m x 6m = 82568,7 kg 
 
However only 15% was taken into account => 0,15 x 82568,7 kg = 12385,31 kg 

 Vibrating mass= 40230 kg + 137614,68 kg + 18348,66 kg + 12385,31 kg 
  = 208578,65 kg 
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Manual Calculation 

In order to check the results of SCIA Engineer, the lowest eigen frequency of this structure is 
calculated by means of the Rayleigh Method.   
As specified in the previous example, the frame is idealized as a cantilever: 

 
 
 
The masses M1, M2 and M3 can be calculated as follows: 

- Self-Weight of three floor beams and four columns: 
 3 x 0,125 m² x 2500 kg/m³ x 6 m  = 5625 kg 
 4 x 0,135 m² x 2500 kg/m³ x 4 m = 5400 kg 
 5625 kg + 5400 kg = 11025 kg 

- Floor weight of mass group MG1: 
 3 x 2548,42 kg/m x 6 m = 45871,56 kg 

- Weight of Imposed load of mass group MG2 (15%) 
 0,15 x 3 x 1529,05 kg/m x 6 m = 4128,44 kg 

- Total: 11025 kg + 45871,56 kg + 4128,44 kg = 61024,995 kg 
 
The mass M4 can be calculated as follows: 

- Self-Weight of three roof beams and half of four columns: 
 3 x 0,045 m² x 2500 kg/m³ x 6 m  = 2025 kg 
 0,5 x 4 x 0,135 m² x 2500 kg/m³ x 4 m = 2700 kg 
 2025 kg + 2700 kg = 4725 kg 

- Roof weight of mass group MG1: 
 3 x 1019,37 kg/m x 6 m = 18348,66 kg 

- Total: 4725 kg + 18348,66 kg = 23073,66 kg 
 
In order to calculate the horizontal deformations di of each floor level due to a linearly increasing 
load Fi, a static load case is calculated with SCIA Engineer consisting of loads of 100 kN, 200 
kN, 300 kN and 400 kN. The following results are obtained for the nodal deformations: 
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 F1 = 100 kN = 100000 N 
 F2 = 200 kN = 200000 N 
 F3 = 300 kN = 300000 N 
 F4 = 400 kN = 400000 N 
 d1 = 33,07 mm = 0,03307 m  
 d2 = 77,92 mm = 0,07792 m 
 d3 = 115,88 mm = 0,11588 m 
 d4 = 151,71 mm = 0,15171 m 

 
Applying formula (2.8): 

       







2222
15171,066,2307311588,0995,6102407792,0995,6102403307,0995,61024

15171,040000011588,030000007792,020000003307,0100000

2

1

mkgmkgmkgmkg

mNmNmNmN
f



 

f 1,27 Hz 

 
This result corresponds to the 1,28 Hz calculated by SCIA Engineer.  
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2.5 Slabs 

The last paragraph of this chapter illustrates the procedure for the Free Vibration calculation of 
slabs. The applied method is entirely the same as for frames. This is shown in the following 
example.  
 

Example 2-4: Free_Vibration_4.esa 

In this example, a multi-span rectangular slab is modeled. The slab has a length and width of 
6m. The slab has a thickness of 0,06m and is manufactured in S235 according to EC-EN. On 
two sides the slab is simply supported, on the other two, the slab is free. In the middle of the 
slab, perpendicular on both simply supported edges, a line support is introduced. 
One static load case is created: the self-weight of the slab.  

 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionality Dynamics on the 
Functionality tab in the Project Data. 
 

Step 2: Mass group 

The second step is to create a Mass Group 
 
Since the Free Vibration calculation will be executed for the self-weight of the slab, no additional 
masses need to be inputted. 
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Step 3:  Mass matrix 

Next, a Combination of Mass Groups can be created. 
 

 
 

Step 4: Mesh setup 

To obtain precise results for the dynamics calculation, the Finite Element Mesh is refined. 
Analogous as for frames, this can be done through Calculation, Mesh > Mesh Setup. 
 

 
 
The Average size of 2D elements is set to 0,25m. 
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Step 5: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be 
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this 
example. 
 

 
 

Step 6: Modal analysis 

The Free Vibration calculation can now be executed through Calculation, Mesh > Calculation. 
The following results are obtained: 

 
 
The same way as for frames, the Eigenmodes can be visualized through Deformation of nodes 
now under 2D Members. The Deformed structure for value Uz shows the following: 

 

   
Eigenmode 1: f = 6,68 Hz    Eigenmode 2: f = 9,44 Hz 
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Eigenmode 3: f = 19,39 Hz   Eigenmode 4: f =21,05 Hz 
 

Note: 

- Viewing 2D Members > Deformation of nodes > Deformed Mesh shows the deformation of both 

2D and 1D elements. This allows seeing the complete eigenmode for a structure containing both 

element types i.e. General XYZ projects.  

- To generate all eigenmodes quickly, the document can be used: The picture of one eigenmode can 

be set as a nested table for the Combinations of Mass Groups: 

 

 
 

This way, all Eigenmodes are generated automatically. 

 
The Calculation Protocol for the Eigen Frequency calculation shows that the following Sum of 
masses is accounted for: 

 
 

 
This value can be calculated as follows: 

- The total weight of the slab is 6 m x 6 m x 0,06 m x 7850 kg/m³ = 16956 kg 
- Half of the mass of the elements near the two externally supported edges is carried to the 

supports and does not participate in the vibration. Since the mesh size was set to 0,25 m, 
half the size of a 2D element is 0,125 m. 

 2 x 6 m x 0,125 m x 0,06 m x 7850 kg/m³ = 706,5 kg 
 

- The same applies for the internal edge,  
however the mass of the two elements on the start 
and end nodes has already been taken into 
account in the above calculation for the externally 
supported edges.  
 
This leaves a length of 6 m – 0,125 m – 0,125 m = 
5,75 m. The following figure illustrates this length. 

 2 x 5,75 m x 0,125 m x 0,06 m x 7850 
kg/m³ = 677,06 kg 
 

 
 

- The total mass taken into account for the Free 
Vibration calculation: 

 16956 kg – 706,5 – 677,06 = 15572,44 kg 
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Manual Calculation 

In order to check the results of SCIA Engineer, the eigen frequencies of the slab are calculated 
by a manual calculation. 
The method used here is described in reference [14] In this reference; the eigen frequency of a 

multi-span slab is expressed in terms of a non-dimensional parameter . 

D

hL 






2

2

          (2.10) 

 
Where:  

    = Circular frequency 
 L = Distance between the two simply supported external edges 

  = Density of the slab material 
 h = Slab thickness 

 D = flexural rigidity of the slab 
 2

3

112 


Eh
  (2.11) 

 E = Modulus of Young 

  = Poisson’s Ratio 
 
In this example, the material properties are the following: 
 L = 6 m 

  = 7850 kg/m³ 
 h = 0,06 m 
 E = 210.000 N/mm² = 2,1 e

11
 N/m² 

     = 0,3 

 D = 

 

 






2

3

2
11

3,0112

06,01,2 m
m

Ne
4153846,15 Nm 

 

The values for  for the first four modes, for a slab with two edges simply supported and two 
edges free, a h/L ratio of 0,01 and an internal edge on position 0,5L are given in reference [14]: 

Mode 1:  = 1,6309 

Mode 2:  = 2,3050 

Mode 3:  = 4,7253 

Mode 4:  = 5,1271 
 
Using these parameters in formula (2.10), the circular frequencies can be calculated: 

Mode 1:  = 41,99 rad/s => f = 6,68 Hz 

Mode 2:  = 59,34 rad/s => f = 9,45 Hz 

Mode 3:  = 121,66 rad/s  => f = 19,36 Hz 

Mode 4:  = 132 rad/s  => f = 21,01 Hz 
 
The results correspond perfectly to the results calculated by SCIA Engineer: 

Mode 1: f = 6,68 Hz 
Mode 2: f = 9,44 Hz 
Mode 3: f = 19,39 Hz 
Mode 4: f = 21,05 Hz 
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3. Forced Vibration: Harmonic Load 

 
In this chapter, the forced vibration calculation is examined. More specifically, the structure will now be 
loaded with an external harmonic load, which will cause the structure to vibrate.  
A forced vibration calculation can be required to check the response of a building near a railroad or 
major traffic lane, to check vibrations due to machinery, to verify structural integrity of a floor loaded by 
an aerobics class,… 
As in the previous chapter, first the theory will be discussed. The theory will then be illustrated by 
examples, which will again be verified by manual calculations. 
 

3.1 Theory 

To understand what is going on during the dynamic analysis of a complex structure with frames or finite 
elements, the forced vibration of a SDOF (Single Degree Of Freedom) system is regarded in detail. A 
complete overview can be found in reference [1]. 
 
Consider the following system: 

 
 
A body of mass m can move in one direction. A spring of constant stiffness k, which is fixed at one 
end, is attached at the other end to the body. The mass is also subjected to damping with a damping 
capacity c. An external time dependant force F(t) is applied to the mass. 
The equation of motion can be written as: 

)()()()( tFtyktyctym 


      (3.1) 

 
When the acting force on this system is a harmonic load, equation (3.1) can be rewritten as follows: 

)sin()()()( tFtyktyctym 


      (3.2) 

 
Where: F = Amplitude of the harmonic load 

   = Circular frequency of the harmonic load 
 
A solution to this equation is the following: 
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Where:   

k

F
YS     The static deflection    (3.4) 







m

c

2
   The damping ratio    (3.5) 

21  D    The damped circular frequency   (3.6) 
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          (3.7) 
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r     The frequency ratio    (3.8) 

 

The angle  signifies that the displacement vector lags the force vector, that is, the motion occurs after 
the application of the force. A and B are constants which are determined from the initial displacement 
and velocity. 
The first term of equation (3.3) is called the Transient motion. The second term is called the Steady-
state motion. Both terms are illustrated on the following figure: 
 

 
 

The amplitude of the transient response decreases exponentially (
te 
).  Therefore, in most practical 

applications, this term is neglected and the total response y(t) can be considered as equal to the 
steady-state response (after a few periods of the applied load). 
Equation (3.3) can then be written in a more convenient form: 

222 )2()1(

1

rrY

Y

S 
        (3.9) 

SY
Y is known as the Dynamic Magnification factor, because YS is the static deflection of the system 

under a steady force F and Y is the dynamic amplitude. 
 

The importance of mechanical vibration arises mainly from the large values of 
SY

Y experienced in 

practice when the frequency ratio r has a value near unity: this means that a small harmonic force can 
produce a large amplitude of vibration. This phenomenon is known as resonance. In this case, the 

dynamic amplitude does not reach an infinite value but a limiting value of 
2

SY
. 
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3.2 Harmonic Load in SCIA Engineer 

In SCIA Engineer, a Harmonic Load can be inputted after creating a Combination of Mass Groups. This 
implies that the steps used to perform a Free Vibration calculation still apply here and are expanded by 
the properties of the Harmonic Load. 
Conform the theory, a Harmonic Load is defined by a forcing frequency and an amplitude. To specify 
the damping ratio of the structure, the logarithmic decrement can be inputted. [1] 

The logarithmic decrement   is the natural logarithm of the ratio of any two successive amplitudes in 
the same direction. This is illustrated on the following figure: 

11

1ln
X

X
          (3.10) 

 
 

The logarithmic decrement   is related to the damping ratio   by the following formula: 

21

2






           (3.11) 

 
The damping ratio and the logarithmic decrement are looked upon in more detail in Chapter 5. 
Harmonic Loads in SCIA Engineer are always defined as nodal forces i.e. a nodal load or a nodal 
moment. More than one node of the structure can be loaded in a load case, but the frequency of all 
solicitations is equal to the forcing frequency specified for that load case. 
 
As specified in the theory, the static results are multiplied by the dynamic magnification factor. The 
dynamic calculation is thus transformed to an equivalent static calculation. Therefore, a Linear 
Calculation needs to be executed. During this calculation, the Free Vibration Calculation will also be 
performed since this data is needed for the result of the Harmonic Load. 
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The following diagram shows the required steps to perform a Forced Vibration calculation: 
 

 
 
This diagram is illustrated in the following examples. 
 

  

 Activate the Dynamics functionality 

Input Masses Generate Masses from Static Load cases 

Create a Mass Group 

Create a Mass Combination 

Perform a Linear Calculation 

Refine the Finite-Element Mesh if required 

Specify the number of Eigenmodes to be calculated 

Create a Harmonic Load case 

Input Harmonic Loads 
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Example 3-1: Harmonic_Load_1a.esa 

In this example, a beam on two clamped supports is modeled. The beam has a cross-section type IPE 
200, a length of 6m and is manufactured in S235 according to EC-EN. A node has been added to the 
middle of the beam, in which a mass of 200 kg will be inputted. 
 

 
 
One static load case is created: the self-weight of the beam. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of S235 can be set to 1 kg/m³ in 
the Material Library. This will render it easier to check the results through a manual calculation. 
The mass of 200 kg is vibrating with a frequency of 5 Hz. The damping ratio of the system is taken as 
5%. 
 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionality Dynamics on the Functionality 
tab in the Project Data. 
 

Step 2: Mass group 

The second step is to create a Mass Group 

 

Step 3: Masses 

After the Mass Group has been created; the mass of 200 kg can be inputted in the middle of the beam. 

 

Step 4: Mass matrix 

Next, the Mass Group is put within a Combination of Mass Groups, which can be used for defining 
the harmonic load. 
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Step 5: Harmonic load case 

After creating a Combination of Mass Groups, an harmonic load case can be defined through Load 
cases, Combinations > Load Cases. 

- Action Type =  Variable 

- Load Type =  Dynamic 

- Specification =  Harmonic 
 

 
 

The damping ratio was given to be 5%. Applying formula (3.11), the logarithmic decrement can be 
calculated: 
 

 
93145527022,0

05,01

05,02

1

2

22















 

This formula can also be inserted in the value field. It is not necessary to do a manual calculation to 
insert only the result in SCIA Engineer. 
 
 
The forcing frequency of the harmonic load is 5 Hz. This must be inserted in the Frequency [Hz] field. 

 
 

The last option, Mass Combi shows which Mass Combination (mass matrix) will be used for the 
calculation of the harmonic load case. 
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Step 6: Load 

The parameters of the load case have been defined, what is left is inputting the amplitude of the load. 
The mass was 200 kg.  
This corresponds to a load of 1,962 kN using 9,81 m/s² for the acceleration of gravity. 
This load can be inputted through Load > Point Force > In Node 

 
 

Note: 

As specified in the theory, more than one harmonic load can be inputted in the same harmonic load case 

however the harmonic parameters like damping and forcing frequency are defined on the level of the load 

case. This implies that, for example, when several harmonic loads are vibrating with different frequencies, 

different load cases have to be created. 

 

Step 7: Mesh setup 

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined. 
This can be done through Calculation, Mesh > Mesh Setup. 
 

 
 
The Average number of tiles of 1D element is set to 10. 
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Step 8: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be calculated. 
For this example, only one eigenmode is required so in Calculation, Mesh > Solver Setup the 
number of frequencies is set to 1. 
To compare the results with a manual calculation, the shear force deformation is neglected. 
 

 
 

Step 9: Calculation 

All steps have been executed so the Linear Calculation can be started through Calculation, Mesh > 
Calculation. 
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This gives the following results: 

 
 
The deformation for the harmonic load shows the following: 

 

 
 
It is however very important so keep in mind that this is a vibration: half a period later the deformation 
is to the upper side of the beam instead of the lower side. 
 
The moment diagram for the harmonic load would give the next diagram: 
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This diagram is completely analogous to the moment diagram which one finds for a simple point load. 
 
However, when performing dynamic calculations, one must always take into account both directions of 
the loading since the load vibrates in both directions.  
In SCIA Engineer, this double sided deformation can easily be checked by creating combinations of 
type code or envelope. In these combinations, the dynamic load cases will be accounted for with both 
a positive and a negative combination coefficient and thus both sides of the vibration amplitude are 
taken into account. 
 
In this example, a combination of type Envelope - ultimate is created which contains only the 
harmonic load case. 
 

  
 
The moment diagram for this combination shows the following: 

 
 

 
The vibration effect is correctly taken into account: both sides of the vibration are visible. This is also 
shown in the Combination Key of the Document; which shows the two generated Linear 
combinations from the Envelope combination (Local Extremes): 
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Manual Calculation 

In order to check the results of SCIA Engineer, a manual calculation is performed. 
First, the calculated eigen frequency is checked using formula (2.3). 
Using default engineering tables [11], the maximum static deformation of a beam with length L, 
clamped at both sides and loaded with a load F in the middle is given as: 

EI

FL

192

3

max           (3.12) 

 
Where:  

F = 1,962 kN = 1962 N 
L = 6m = 6000 mm 
E = 210000 N/mm² 
I = 19430000 mm

4
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mm
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The rigidity k of this system can then be calculated: 

m
N

mm
N

mm

NF
k 33,362693393,3626

54095,0

1962

max




 

 
Applying formula (2.3): 

s
rad

kg

m
N

m

k
67,134

200

33,3626933
  

 




2
f 21,43 Hz 

 
This result corresponds exactly to the result calculated by SCIA Engineer. 
 
Now the eigen frequency is known, the results of the harmonic load can be verified. 
The harmonic load had a forcing frequency of 5 Hz, which corresponds to a circular frequency of 
31,416 rad/s. 
 
Applying formula (3.8) the frequency ratio can be calculated: 



s
rad

s
rad

r
67,134

416,31




0,233289 

 
The frequency ratio can then be used in formula (3.9) to calculate the Dynamic Magnification Factor: 

   








222222

0,050,23328920,2332891
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1,0572 

 
This implies that the static results need to be multiplied by 1,0572 to obtain the dynamic results. 

The static deformation was calculated as mm54095,0max   

 Dynamic deformation = 1,0572 x 0,54095 mm = 0,5719 mm 
 
This result corresponds exactly to the result calculated by SCIA Engineer. 
 
In the same way the moment in the middle of the beam can be calculated.  
Using default engineering tables [11], the maximum static moment in the middle of a beam with length 
L, clamped at both sides and loaded with a load F in the middle is given as: 
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kNm
mkNFL

M 4715,1
8

6962,1

8



  

 Dynamic moment = 1,0572 x 1,4715 kNm = 1,556 kNm 
 

This result corresponds exactly to the result calculated by SCIA Engineer.  
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3.3 Resonance 

As specified in the theory, resonance occurs when the frequency ratio r has a value near unity. In this 
case, large values for the Dynamic Amplification factor are obtained. 
To illustrate this, the calculation of the Dynamic Amplification Factor is repeated for different frequency 
ratios and different damping percentages. The results are given in the following table: 
 
In order to draw conclusions, the numerical results are plotted graphically: 

 
 

 
 

Frequency Forcing Mag. factor Mag. factor Mag. factor Mag. factor Mag. factor Mag. factor

Ratio Frequence [Hz] Damping 5% Damping 8% Damping 10% Damping 15% Damping 25% Damping 50%

0,0 0,00 1,0000 1,0000 1,0000 1,0000 1,0000 1,0000

0,2 4,29 1,0414 1,0411 1,0408 1,0396 1,0361 1,0198

0,4 8,57 1,1891 1,1870 1,1851 1,1785 1,1581 1,0748

0,6 12,86 1,5557 1,5452 1,5357 1,5041 1,4148 1,1399

0,8 17,15 2,7116 2,6173 2,5384 2,3113 1,8582 1,1399

1,0 21,43 10,0000 6,2500 5,0000 3,3333 2,0000 1,0000

1,2 25,72 2,1926 2,0830 1,9952 1,7590 1,3440 0,7824

1,4 30,01 1,0308 1,0144 1,0000 0,9543 0,8417 0,5891

1,6 34,29 0,6377 0,6326 0,6280 0,6127 0,5704 0,4475

1,8 38,58 0,4450 0,4428 0,4408 0,4340 0,4142 0,3480

2,0 42,87 0,3326 0,3315 0,3304 0,3269 0,3162 0,2774

2,2 47,15 0,2600 0,2593 0,2587 0,2567 0,2503 0,2260

2,4 51,44 0,2098 0,2094 0,2090 0,2077 0,2037 0,1876

2,6 55,73 0,1734 0,1732 0,1729 0,1720 0,1694 0,1582

2,8 60,01 0,1461 0,1459 0,1457 0,1451 0,1432 0,1353

3,0 64,30 0,1249 0,1248 0,1246 0,1242 0,1229 0,1170

3,2 68,59 0,1082 0,1081 0,1080 0,1076 0,1066 0,1023

3,4 72,87 0,0946 0,0946 0,0945 0,0943 0,0935 0,0901

3,6 77,16 0,0836 0,0835 0,0835 0,0833 0,0827 0,0801

3,8 81,45 0,0744 0,0743 0,0743 0,0741 0,0737 0,0716

4,0 85,73 0,0666 0,0666 0,0666 0,0665 0,0661 0,0644

4,2 90,02 0,0601 0,0600 0,0600 0,0599 0,0596 0,0583

4,4 94,31 0,0545 0,0544 0,0544 0,0543 0,0541 0,0530

4,6 98,59 0,0496 0,0496 0,0496 0,0495 0,0493 0,0484

4,8 102,88 0,0454 0,0453 0,0453 0,0453 0,0451 0,0443

5,0 107,17 0,0417 0,0416 0,0416 0,0416 0,0414 0,0408
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First of all, the resonance phenomenon is clearly visible. When the frequency ratio equals unity, the 
Dynamic Magnification factor becomes very large indicating that a small harmonic load can produce a 
large amplitude of vibration. 
Second, the influence of the damping ratio on the system response in resonance is significant.  
With a damping ratio of 5%, the magnification factor is about 10; with a damping ratio of 50%, the 
magnification factor is reduced to 1. 
 
In general, the following can be concluded from this graphic [1]: 
The system response at low frequencies is stiffness-dependent. In the region of resonance, the 
response is damping-dependent and at high frequencies, the response is governed by the system 
mass: mass-dependent. 
It is important to keep this in mind when attempting to reduce the vibration of a structure. For example, 
the application of increased damping will have little effect if the excitation and response frequencies are 
in a region well away from resonance, such as that controlled by the mass of the structure. 
 
 
The effect of resonance can also be illustrated in SCIA Engineer. 
In the project “Harmonic_Load_1”, the excitation frequency is 5Hz. The eigenfrequency is 21.43 Hz.  
So this is not in the resonance area. 
 
To see the response in function of the frequency, we can create several load cases with other 
excitation frequency. You can easily do this by copying the existing load case and changing the 
excitation frequency. This is shown in the next example. 
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Example 3-2: Harmonic_Load_1b_5-30Hz.esa 

 
This example is a continuation of the previous example. 
We have copied the harmonic load case and changed the name, description and frequency in each 
load case. 

 
 

Those load cases can then be grouped in a class.  

 
  



Advanced Professional Training - Dynamics 

64 

In the result menu, we can for instance ask for the Uz 
displacement of the middle node.  
 
By asking the result for the class of the load cases 5-30 Hz,  
we can see clearly the effect of resonance if the excitation 
frequency is near the eigenfrequency.  
 
 
 
 
 
 
 
 
 
 

 
 
 

Note: 

In SCIA Engineer, the logarithmic decrement is limited between 0,0001 and 10. The lower limit corresponds to 

a damping ratio  0,0016%. Zero damping is impossible since this would lead to an infinite response (division 

by zero) in resonance.  

The upper limit corresponds to a damping ratio  85%. For structural vibrations, this is an extreme value, 

which, in nearly all cases, will never be attained. Damping will be discussed in more detail in Chapter 5. 
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Example 3-3: Harmonic_Load_2.esa 

 
Another common application of a harmonic load is a structure loaded with a plunger system or a motor. 
Both the reciprocating effect of the plunger and the rotating unbalance of the motor produce an exciting 
force of the inertia type on the system. 

For an unbalanced body of mass mr, at an effective radius e, rotating at an angular speed , the 
exciting force F can be written as [1]: 

2 emF r          (3.13) 

 
This is illustrated in the following example. 
 
 
 
An electric motor with a mass of 500 kg is mounted on a simply supported beam with overhang. The 
beam has a cross-section type HEA 240 and is manufactured in S235 according to EC-EN. The beam 
has a length of 4m and the overhang is 3m. 
The motor has an unbalance of 0,6 kgm. The damping ratio of the system is taken as 10%. 

 
The motor can operate at speeds of 800, 1000 and 1200 rpm. For each of these speeds, the amplitude 
of forced vibration needs to be calculated to check, for example, if the vibrations induced by the motor 
are acceptable. 
One static load case is created: the self-weight of the beam. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of S235 can be set to 1 kg/m³ in 
the Material Library. This will render it easier to check the results through a manual calculation. 
A node has been added to the middle of the overhang to specify the location of the motor. 
 

 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionality Dynamics on the Functionality 
tab in the Project Data. 
 
 

Step 2: Mass group 

The second step is to create a Mass Group. 
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Step 3: Masses 

After the Mass Group has been created; the 500 kg mass of the motor can be inputted in the middle of 
the overhang.  

 
 

Step 4: Mass matrix 

Next, the Mass Group is put within a Combination of Mass Groups, which can be used for defining 
the harmonic loads at the different speeds. 

 
 

Step 5: Load cases 

After creating the Mass Combination, three harmonic load cases can be defined, one for each speed. 
Each load case uses the same Mass Combination and has the same damping specifications. 
The damping ratio was given to be 10%. Applying formula (3.11) the logarithmic decrement can be 
calculated: 

 
996314838833,0
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2
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The forcing frequency is different for each load case and can be calculated from the given speeds: 

s
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    Hzf 33,13800   
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Step 6: Harmonic force 

The parameters of the harmonic loads have been defined. What is left is inputting the amplitude of the 
three exciting forces. 
Using formula (3.13) these forces can be calculated from the forcing circular frequency and the mass 
unbalance. 

  kNN
s

radkgmemF r 21,403,421178,836,0
2

2

800800    

  kNN
s

radkgmemF r 58,674,657972,1046,0
2

2

10001000    

  kNN
s

radkgmemF r 47,982,947466,1256,0
2

2

12001200    

 
 
The loads are inputted through Load > Point Force > In Node 
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Step 7: Mesh setup 

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined. 
This can be done through Calculation, Mesh > Mesh Setup. 
 

 
 
The Average number of tiles of 1D element is set to 10. 
 
 

Step 8: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be calculated. 
For this example, only one eigenmode is required so in Calculation, Mesh > Solver Setup the 
number of frequencies is set to 1. 
To compare the results with a manual calculation, the shear force deformation is neglected. 
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Step 9: Calculation 

All steps have been executed so the Linear Calculation can be started through  
Calculation, Mesh > Calculation. 
 
This gives the following results: 

 
 
The nodal deformations for the harmonic loads at the location of the motor are the following: 
 
At 800 rpm: 

 
 
At 1000 rpm: 

 
 
At 1200 rpm: 

 
 
As stated in the previous example, it is important to keep in mind that the signs are not relevant since a 
vibration occurs on both sides of the equilibrium position. 
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Manual Calculation 

In order to check the results of SCIA Engineer, a manual calculation is performed [15]. 
First, the calculated eigen frequency is checked using formula (2.3) 
Using default engineering tables [11], the maximum static deformation of a simply supported beam with 
length L, an overhang with length a and loaded with a load F at the end of the overhang is given as: 

 

 
EI

aLFa

3

2

max


          (3.14) 

 
 
The rigidity k of this system can then be calculated: 

)(

3
2

max aLa

EIF
k





 

 
Where: L = 4m = 4000 mm 

 a = 1,5m = 1500 mm 
 E = 210000 N/mm² 
  I = 77600000 mm

4
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Applying formula (2.3): 

s
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m
N

m

k
89,88

500

45,3950545


 

 




2
f 14,15 Hz 

 
This result corresponds exactly to the result calculated by SCIA Engineer. 
 
Applying formula (3.8) the frequency ratios can be calculated for each motor speed: 
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The frequency ratios can then be used in formula (3.9) to calculate the Dynamic Magnification Factors. 
When also applying formula (3.4) the Dynamic Amplitude can be calculated for each speed: 
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These results correspond exactly to the results calculated by SCIA Engineer.  
In the same way as in the previous example, the calculation can be repeated for several angular 
velocities. The result is shown graphically on the following figure: 
 

 
 
The main feature to notice is the decrease in vibration amplitude when the forcing frequency increases 
due to moving away from resonance. [15] 
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4. Spectral Analysis: Seismic Load 

 
In this chapter the seismic analysis in SCIA Engineer is explained in detail. 
During an earthquake, the subsoil bearing a structure moves. The structure tries to follow this 
movement and as a result, the masses in the structure begin to move. Subsequently, these masses 
subject the structure to inertial forces. When these forces are determined, they can be applied to the 
structure and thus, like with the harmonic load, the dynamic calculation is transformed to an equivalent 
static. 
In the first part of the chapter, the theory will be explained. The theory will then be illustrated by 
examples, which are again verified by manual calculations. 
 

4.1 Theory 

General 

Analogous to the previous chapters, before examining the dynamic analysis of a complex structure, the 
Seismic analysis of a SDOF (Single Degree Of Freedom) system is regarded in detail. A complete 
overview can be found in references [2], [3].  
Generally, this paragraph deals with the analysis of structures that are submitted to a harmonic ground 
motion.  The most important harmonic ground motions are earthquakes (seismic loads), but this 
calculation method can also be applied to the analysis of underground or surface explosions and 
vibrations generated by heavy traffic or machinery. 

The following figure illustrates the displacement of a system that is submitted to a ground motion: 

 

 
Where: yg(t) is the ground displacement 

y(t) is the total displacement of the mass 
  u(t) is the relative displacement of the mass 
 
The total displacement can thus be expressed as follows: 

)()()( tutyty g         (4.1) 

 Since yg is assumed to be harmonic, it can be written as: 

)sin()( tYty gg          (4.2) 

The equilibrium equation of motion can now be written as: 

0)()()( 


tuktuctym      (4.3) 

 
Since the inertia force is related to the total displacement (y) of the mass and the damping and spring 
reactions are related to the relative displacements (u) of the mass. 
 

  

y
g
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y(t)
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When (4.1) is substituted in (4.3) the following is obtained: 

0)()())()(( 


tuktuctytum g  

or 


 )()()()( tymtuktuctum g     (4.4) 

This equation is known as the General Seismic Equation of Motion. This equation can be used to 
illustrate the behavior of structures that are loaded with a seismic load: 

Substituting (4.2) in (4.4) gives the following: 

)sin()()()( 2 tYmtuktuctum g 


  

 
This equation can be compared with equation (3.2) of the previous chapter. As a conclusion, the 
ground motion can also be replaced by an external harmonic force with amplitude: 

2 gYmF  

 
But an earthquake will be a combination of many of harmonic load acting on different frequencies 
simultaneously. The load represented in these harmonic loads is the acceleration of the structure 
multiplied with the mass of the structure. The frequencies of these harmonic loads are the frequencies 
on which this acceleration occurs in the earthquake.  
 
The combination of all the accelerations over the different frequencies in the earthquake will be given 
by a response spectrum. A response spectrum is therefore nothing more than a list of accelerations 
and the frequencies on which they occur. 

Response Spectra 

When a structure has to be designed for earthquakes, in most cases spectral analysis is used because 
the earthquake loading is often described as a response spectrum. 
This response spectrum can either be a displacement, velocity or acceleration spectrum. 

The relation of an earthquake (given by an acceleration time-history) and the corresponding 
displacement response spectrum is given by [16]: 

max

)( ))(sin()(
1

),( 







 







  dTeyS T

gd    (4.5) 

Where: )(
g

y


 is the ground acceleration in function of time 

  is the damping factor 

T is the period 2  

Instead of the displacement response spectrum Sd, also the velocity response spectrum Sv or the 
acceleration response spectrum Sa can be used.  These three spectra are related by  : 

dva SSS  2        (4.6) 

 
In Eurocode 8 [7] the earthquake motion at a given point on the surface is represented by an elastic 
ground acceleration response spectrum or “Elastic Response Spectrum Se” This spectrum is 
illustrated in the following figure: 
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A commonly used way of describing an earthquake magnitude is the so-called Richter scale. Annex A 
gives a relation between the magnitude on the Richter scale and the Peak Ground Acceleration. 

Spectral Analysis 

For MDOF (Multiple Degree Of Freedom) systems, equation (4.4) can be written in matrix notation as a 
set of coupled differential equations: 

 gYMUKUCUM


 1     (4.7) 

 
The matrix {1} is used to indicate the direction of the earthquake.  E.g. for a two-dimensional structure 
(three degrees of freedom) with an earthquake that acts in the x-direction, the matrix is a sequence like 
{1,0,0,1,0,0,1,0,0,…} 
 
The resulting set of coupled differential equations is reduced to a set of uncoupled differential equation 

by a transformation U = Z.Q, where Z is a subset of   (the eigenvectors) and Q is a vector, which is 
time-dependent.   

 gYMQZKQZCQZM


 1 ; or 

 g
TTTT YMZQZKZQZCZQZMZ



 1  

This can be simplified to a set of uncoupled differential equations: 

 g
T YMZQQCQ



 12*
    (4.8) 

Where 
*C  is a diagonal matrix containing terms like ii2 . 

 
Each equation j has a solution of the form: 
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))(sin()(

1
1 




  (4.9) 

To obtain the maximum displacements, the displacement response spectrum Sd of equation (4.5) can 
be substituted: 

 ),(1max, jjd

T

j SMZQ         (4.10) 

 
Since U = Z.Q: 

 ),(1max, jjd

T

j SMZZU  ; or 

),(max, jjdj SZU        (4.11) 

Where  1 MZ T
 is known as the modal participation factor. 
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4.2 Seismic Load in SCIA Engineer 

Response Spectra in SCIA Engineer 

In SCIA Engineer, a Seismic Load can be inputted after creating a Combination of Mass Groups. This 
implies that the steps used to perform a Free Vibration calculation still apply here and are expanded by 
the properties of the Seismic Load. 
 
As specified in the theory, Eurocode 8 [7] specifies an Elastic Response Spectrum Se. For design 
purposes, this spectrum is reduced to a Design Spectrum Sd. This Design Spectrum is dependent on 
several parameters: the Ground Type, the Ground Acceleration, the Behavior Factor and the 
Damping. 
 
 
When defining a spectrum in SCIA Engineer, the spectrum can be defined either by combinations of 
Frequencies & accelerations, or Periods & accelerations, or by simply inputting the parameters that 
define this spectrum according to Eurocode 8. If the user wishes to compose the spectrum based on 
the parameters in Eurocode 8, then he will have the next input window: 
 

 
 

For a detailed description of these parameters, reference is made to Eurocode 8 [7]. The following is a 
brief overview for understanding the input needed for SCIA Engineer.  

- Damping: The Design Spectra of Eurocode 8 are defined for a damping ratio of 5%. If the 
structure has another damping ratio, the spectrum has to be adapted with a damping correction 

factor . This will be looked upon in more detail in Chapter 5. 

 

- Ground Acceleration: The ground acceleration ag or the coefficient of acceleration  can be 
calculated from agR by means of an importance factor.  

 The ground acceleration ag can be calculated from the importance factor and the peak 
ground acceleration (PGA) agR: 

                  (4.12) 
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 The Coefficient of Acceleration  is defined as the ground acceleration divided by the 
acceleration of gravity g: 

g

ag
        (4.13)  

 

 The importance factor is derived from the return period of the seismic action and the 

importance of the structure. An importance factor    equal to 1,0 is assigned to the 
reference return period. 

 

 The peak ground acceleration (PGA) agR can be found from the seismic zones in 
which a country is divided. By definition, the seismic hazard within each zone is 
assumed to be constant. The hazard is described by a single parameter: the peak 
ground acceleration (PGA) agR. The following figure illustrates the division in seismic 
zones for the map of Belgium [9]: 

 
 

- Behavior Factor (EN1998, 3.2.2.5): To avoid explicit inelastic structural analysis in design, the 
capacity of the structure to dissipate energy, mainly through ductile behavior of its elements, is 
taken into account by performing an elastic analysis based on a response spectrum reduced 
with respect to the elastic one. This reduction is accomplished by introducing the behavior factor 
q. 

 For the vertical component of the seismic action a behavior factor q up to 1,5 should 
generally be adopted for all materials and structural systems. The adoption of values of 
q greater than 1,5 in the vertical direction should be justified through proper analysis. 

 The values of the behavior factor q, which also account for the influence of the viscous 
damping being different from 5%, are given for various materials and structural systems 
according to the relevant ductility classes in the various Parts of EN 1998. The value of 
the behavior factor q may be different in different horizontal directions of the structure, 
although the ductility classification shall be the same in all directions. 

 

- Beta: The lower bound factor ( ) for the horizontal design spectrum. The recommended value 

for ( ) is 0,2 but can be overruled by the relevant national annex. 

 If you plot the spectrum as acceleration to frequency, then the most left value would be 
the lower bound factor multiplied with the ground acceleration. 
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 S, Tb, Tc, Td manually?: If you set this to ‘No’, then the values to compose the spectrum are 
calculated automatically from the other properties in this window.  

 

 Ground Type: The Ground Type is dependent on the soil characteristics and is specified by 
letters A to E.  

 
 

- Type of spectrum: If the earthquakes that contribute most to the seismic hazard defined for the 
site for the purpose of probabilistic hazard assessment have a surface-wave magnitude, Ms, not 
greater than 5,5, it is recommended that the Type 2 spectrum is adopted. A simple formula to 
find the surface wave magnitude from the Richter magnitude scale ([29]) is: 

                         (4.14) 

- Direction: If the spectrum is applied in X or Y direction, then this must be set to ‘Horizontal’. If 
the spectrum is to be applied in the Z direction, then this property must be set to ‘Vertical’. 

 

 

Calculation Protocol 

In the calculation protocol of SCIA Engineer the intermediate results that were determined while 
calculating the global effect of a spectral loading can be found. 
 
This paragraph describes the formulas that have been used to determine those intermediate results. 
 
 
Natural circular frequency and modal shape 
 

Mass matrix DM ][  

Mass vector }1{][}{  DMm  

Natural circular 
frequency of mode 
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)( j  
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Natural normalized 
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Response of mode shape j 
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The calculation of these parameters will be illustrated with an example further in this chapter. 
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Modal combination methods 

Modal combination methods are used to calculate the response R of a seismic analysis.  The term 
"response" (R) refers to the results obtained by a seismic analysis, i.e. displacements, velocities, 
accelerations, member forces and stresses. 
Because the differential equations were uncoupled, a result will be obtained for each mode j. 
To obtain the global response Rtot of the structure, the individual modal responses R(j) have to be 
combined. 
 
The modal combination methods that are used in SCIA Engineer are: 

1. SRSS-method (Square Root of Sum of Squares) 
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Where: 

)( jR  : The response of mode j 

 

2. CQC-method (Complete Quadratic Combination) 
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Where: 

)()( , ji RR   :  The response of mode i and j 

ji, :  Modal Cross Correlation coefficients. 
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i , j :  Damping ratio for mode i and j. 

 
This method is based on both modal frequency and modal damping. The CQC-method thus requires 
the input of additional data: a Damping Spectrum to define the damping ratio for each mode.  
In many cases however, there is no procedure to calculate the damping ratio for the higher modes. 
Most of the time, the same damping ratio is then used for all modes [17]. 
 

3. MAX-method 





N

j

jjtot RRR
MAX

1

2
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Where: 

)( jR  :  The response of mode j 

)( MAXjR  :  The maximum response of all modes 

 
Eurocode 8 [7] prescribes the SRSS-method. However this method may only be applied if all relevant 
modal responses are independent of each other. This is met if the period of mode j is smaller or equal 
to 90% of the period of mode i. 
If modal responses are not independent of each other a more accurate procedure like the CQC-
method needs to be used.  
 
The following numerical example shows this difference between SRSS and CQC. 
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Example 4-1: Spectral_Analysis_1.pdf 

A four-storey symmetrical building is modeled in a 3D analysis (from [18], p.15-9). The building is 
symmetrical; however, the centre of mass of all floors is located 25 inches from the geometric centre of 
the building. 

 
The structure has the following natural frequencies for the first 5 modes: 

Mode 1: f = 13,87 Hz 
Mode 2: f = 13,93 Hz 
Mode 3: f = 43,99 Hz 
Mode 4: f = 44,19 Hz 
Mode 5: f = 54,42 Hz 

 
 
It is clear that modes 1 & 2 and 3 & 4 are very closely spaced. It is typical for most three-dimensional 
building structures that they are designed to resist earthquakes from both directions equally. Therefore 
the similar eigenmodes in X and Y-direction have almost the same natural frequencies. 
 
Because of the small mass eccentricity, which is normal in real structures, the fundamental mode 
shape has x, y, as well as torsion components. Therefore, the model represents a very common three-
dimensional building system.  
 
The building was subjected to one component of the Taft 1952 earthquake. An exact time history 
analysis using all 12 modes and a response spectrum analysis were conducted. The maximum modal 
base shears in the four frames for the first five modes are shown in the figure below. 
 
 
The maximal base shear forces are: 

Mode 1: F = -57,53 kN 
Mode 2: F = 52,30 kN 
Mode 3: F = -9,02 kN 
Mode 4: F = 8,12 kN 
Mode 5: F = 0,33 kN 

 
 
 
 

 
 

To obtain the Global Response, these modal responses are combined using both the SRSS-method 
and the CQC-method as well as a sum of the Absolute Values. 
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Now the maximum total base shears using different methods are compared.  

- The time history base shears are exact. 

- The SRSS method produces base shears that under-estimate the exact values in the direction 
of the loads by approximately 30 percent and overestimate the base shears normal to the loads 
by a factor of 10.  

- The sum of the absolute values grossly over-estimates all results. 

- The CQC-method produces very realistic values that are close to the exact time history solution. 
 

 
 

Results for the global Base Shear:    Lateral   Transversal 

 Exact solution using Time-History Analysis:   112,4 kN  5,44 kN 

 Global Base Shear using SRSS:   78,8 kN   78,8 kN 

 Global Base Shear using CQC:   111,1 kN  6,37 kN 
 
In this example, the SRSS-method overestimates the Base Shear by a factor of 10. 
 

For the CQC-method, the following Modal Cross Correlation coefficients i,j are used with a damping 

ratio i,j of 5%.  

Mode 1 2 3 4 5 

1 1,000 0,998 0,006 0,006 0,004 

2 0,998 1,000 0,006 0,006 0,004 

3 0,006 0,006 1,000 0,998 0,180 

4 0,006 0,006 0,998 1,000 0,186 

5 0,004 0,004 0,180 0,186 1,000 

 
It is of importance to note the existence of the relatively large off-diagonal terms that indicate which 
modes are coupled. 
 
If one notes the signs of the modal base shears shown one the previous page, it is apparent how the 
application of the CQC method allows the sum of the base shears in the direction of the external 
motion to be added directly. In addition, the sum of the base shears, normal to the external motion, 
tend to cancel.  
 
The ability of the CQC-method to recognize the relative sign of the terms in the modal response is the 
key to the elimination of errors in the SRSS-method. 
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4.3 Seismic calculation in SCIA Engineer 

 
The following diagram shows the required steps to perform a Spectral Analysis calculation: 
 

 
 
 
As specified in the theory, the dynamic calculation is transformed to an equivalent static calculation. 
Therefore, a Linear Calculation needs to be executed. During this calculation, the Free Vibration 
Calculation will also be performed since this data is needed for the Seismic results. 
The diagram is illustrated in the following examples. 
 

  

 Activate the functionalities     - Dynamics 

- Seismic 

Input Masses Generate Masses from Static Load cases 

Create a Mass Group 

Create a Mass Combination 

Perform a Linear Calculation 

Refine the Finite-Element Mesh if required 

Specify the number of Eigenmodes to be calculated 

Create a Seismic Load case 

Define a Seismic Spectrum 
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Example 4-2: Spectral_Analysis_2.esa 

In this example a three-storey structure is modeled as a cantilever. The members have cross-section 
IPE 200 and are manufactured in S235 according to EC-EN. The height of each storey is 4m. At each 
storey-level, the structure carries a mass of 500 kg. 

 
 
One static load case is created: the self-weight of the structure. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of S235 can be set to 1 kg/m³ in 
the Material Library. This will render it easier to check the results through a manual calculation. 
The structure will be subjected to an earthquake in X-direction according to Eurocode 8, using a 
Design Response Spectrum for Ground Type B with a behavior factor of 2. The coefficient of 
acceleration is 0,35. 
 
 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionality Dynamics on the Functionality 
tab in the Project Data. In order to execute a Seismic calculation, also the Seismic functionality needs 
to be activated: 
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Step 2: Mass group 

The second step is to create a Mass Group. 

 
 

 

Step 3: Masses 

After the Mass Group has been created; the 500 kg masses can be inputted on each 
storey level: 

 
 

 
 

Step 4: Combination of mass groups 

Next, the Mass Group is put within a Combination of Mass Groups,  
which can be used for defining the Seismic load case. 

 
 
 

Step 5: Seismic load case 

After creating a Mass Combination, a Seismic load case can be defined through  
Load cases, Combinations > Load Cases. 

- Action Type =  Variable. 

- Load Type =  Dynamic. 

- Specification =  Seismicity. 
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Now the parameters for the seismic load case will become visible. These parameters will now be 
explained (going from top to bottom). 

 
 

 Direction X, Y, Z: You must tick on a direction to apply a spectrum in this global direction.  
We advise to use 1 direction per load case, and to combine the different load cases in a 
seismic load combination. 

o After ticking on ‘X’, you will see the different spectrums which are already composed in 
the project. You can tick on the three points on the line “Response spectrum X” to go 
to the list with spectrums, and then choose “New” to create a new spectrum. 

 

o It is also possible that there is no spectrum in the project yet. Then after ticking on ‘X’, 
the software will automatically open the list with spectrums and click on “New” for you. 
The next window will pop up. Choose “Input type = Eurocode” and tick on “Code 
Parameters”. 
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o In ‘Code parameters’ the spectrum will be defined (for more details, go to p.76).  

 The coefficient of acceleration ag is 0,35 (see input). 
Note that ag is automatically calculated after changing coeff accel. ag. 

 The behavior factor q is 2,0 (see input). 

 The subsoil type is type B (see input). 

 We use spectrum type 2 (default). 

 The spectrum is used in X (and Y) direction, so the Horizontal direction. 

 

o After changing the parameters, click on ‘OK’ until you get back to the load case. 

 Factor X, Y, Z: This is used to modify the accelerations in the spectrum without changing the 
spectrum parameters.  We advise to set this to 1. 

 Acceleration factor: This factor is multiplied with the factor X, Y, Z (all of them). This factor 
should be set to 1 since the acceleration factor is already used in the parameters of the 
spectrum.. 

 Overturning: This parameter is used when the supports of the structure are above ground 
level. By default, this value equals 0. 

 Accidental eccentricity: Most of the seismic codes require that structures are checked for 
torsion due to mass eccentricity including an additional eccentricity, which is the “accidental 
eccentricity”. Please note, that “accidental eccentricity” may be used only together with the 
reduced model analysis. We will explain the reduced model analysis and accidental 
eccentricity later on. 

 Type of superposition: Here the type of modal superposition can be chosen. In this example, 
the SRSS method is used. The use of the CQC method will be illustrated later on. 

o SRSS: Square Root of the Sum of Squares. Because of the square root in the 
formulas of the modal combination methods, the results are always positive. 

2 2 2 2 2

(1) (2) (3) (4) (5) ....R R R R R R       

o Max: Modified SRSS (method not included or described in Eurocode 8) 
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o CQC: Complete Quadratic Combination 


 


N

i

N

j

jjiitot RRR
1 1

)(,)( 

 
 



Advanced Professional Training - Dynamics 

88 

Note: 

The options under Multiple Eigen Shapes can be used to avoid the errors in the SRSS-method for closely 

spaced modes. As specified in the theory however, it is advised to use the CQC-method in such cases. 

 

 Unify eigenshapes: This option can be used in the seismic analysis in the case of the method 
SRSS. Classical the following formula is used for SRSS: 

 

2 2 2 2 2

(1) (2) (3) (4) (5) ....R R R R R R       

If the option unify eigenshapes is checked, then the following condition is verified: 

  
  

  

                                         

If the check is fulfilled and mode (i) and (j) are multipl, then the superposition will be modified: 

2 2 2 2

(1) (2) (3) (4) (5)( ) ....R R R R R R     
 

 

 Mass in analysis: The user has to verify if 90% of the total mass is included in de modal 
masses. This will be checked later on in the calculation protocol. If the number of total 
participating mass is under 90%, the number of eigen frequencies has to be increased. 

To avoid this check, it is possible to choose missing mass in modes or residual mode. 
 
 

 Signed results  Predominant mode: The user can select the mode shape which will be 
used to define the sign. If automatic is chosen as mode shape, the mode shape with the 
biggest mass participation is used (sum of direction X, Y and Z). This option can be used for 
example for shear walls. 

This result only makes sense if this single eigenmode is clearly the most dominant for that 
spectrum, and all other modes have almost no significance for that spectrum. But since this 
option manipulates the results, we advise you not to use it, unless you have a very good 
knowledge of SCIA Engineer and of seismic calculations. 

 

Note: 

The options under Multiple Eigen Shapes can be used to avoid the errors in the SRSS-method for closely 

spaced modes. As specified in the theory however, it is advised to use the CQC-method in such cases 

(as advised in Eurocode 8, article 4.3.3.3.2). 
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To conclude, the complete set of parameters in the load case will be shown in the image below. 

 
 
 

Step 6: Finite element mesh 

As specified in the previous chapters, the finite element mesh needs to be refined to obtain precise 
results. This can be done through Calculation, Mesh > Mesh Setup.  
For this example however, the default mesh is not refined which will make it easier to verify the results 
by a manual calculation. But for a default dynamic calculation, we advise to change the number of 1D 
elements in the finite mesh to 5 ~ 10 finite elements 
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Step 7: Number of frequencies 

The last step before the seismic results can be checked, is setting a sufficient amount of eigenmodes 
to be calculated. For this example, 2 eigenmodes are chosen. 
In Calculation, Mesh > Solver Setup the number of frequencies is thus set to 2. 
 

 
 
To check if the number of eigenmodes is sufficient, the calculation protocol for the Eigen frequency 
calculation must be checked. To check the calculation protocol, the Modal Analysis has to be done first 
(under Calculation, Mesh > Calculation). 
 

 

 
 

As specified in the first example of this course, the Modal Participation Factors show the amount of 
mass that is vibrating in a specific eigenmode as a percentage of the total mass. 
For the first Eigenmode, 73% of the total mass is vibrating. For the second Eigenmode, 22% is 
vibrating. In total, these two Eigenmodes account for about 94% of the total mass.  
 
According to Eurocode 8 [7] the sum of the effective modal masses for the modes taken into account 
must amount to at least 90% of the total mass of the structure.  
 
This criterion is fulfilled which indicates the two Eigen modes are sufficient for this example.  
But it is important to see that the number of eigenmodes taken into account is only sufficient in the X-
direction to evaluate a dynamic load working in the X-direction. If the total would be under 90%, the 
number of eigenmodes in the solver setup would have to be augmented and the calculation protocol 
for the Eigen Frequency would have to be checked again. 
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Step 8: General results 

The model has been prepared and checked to perform the Linear Calculation. This can be done 
under Calculation, Mesh > Calculation. 
 
Using Displacement of Nodes, the Deformed Structure can be shown to view the eigenmodes: 
 
Eigenmode 1:     Eigenmode 2: 

        
 
There is a separate part Dynamics where the eigen frequencies can be checked: 

  
 
The deformations caused by the seismic load case can also be checked under Seismic detailed. 
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The details of the seismic calculation can be found in the Calculation Protocol (Linear Calculation): 
 

 
 
The Damping ratio shows the manually inputted damping ratio for the respective Eigenmodes.  
It is important to keep in mind that the Seismic Spectra of Eurocode 8 have been calculated with a 
damping ratio of 5% as specified in the theory. When a damping ratio is manually inputted, the spectra 
need to be adapted. This is done through the Damping Coefficient. 
 

 Sax, Say & Saz: These show the spectral accelerations. 

 G(j): This shows the mode coefficient for mode j. 

 Fx & Fy: These are the Base Shears for each mode. 

 Mx & My: These are the Overturning Moments for each mode.  
 

The last line in the table shows the global response. This response was obtained by means of the 
SRSS-method for combining the modal responses. 
The formulas for these parameters have been shown in the theory and a manual check can be found in 
annex C. 
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Example 4-3: Spectral_Analysis_3.esa 

The previous example is repeated and will now be calculated using the CQC-method. For all 
frequencies, a damping ratio of 2% is used. In Step 6, CQC is chosen in the Type of evaluation box:  

 
 

Using the button  behind CQC, a damping spectrum can be inputted. Since for this example a 
constant damping ratio will be used for all eigenmodes, the ratio of 2% is inputted starting from 
frequency 0 Hz to 100 Hz  
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This damping spectrum will be used for the calculation of the Modal Cross Correlation coefficients of 
the CQC-method and will also be used to calculate the Damping Coefficient for each mode as 
specified in the previous example. 
 
When the spectrum has been inputted, the Linear Calculation can be re-run. 
 
The following results are obtained through the Calculation protocol of the Linear Calculation: 

 
 
The results show that for each mode, the Damping Ratio is equal to 2%. 
 
 
As specified in the theory, the Seismic Spectra of Eurocode 8 have been defined using a Damping 
Ratio of 5%. Since now another value is used for the damping, the spectrum needs to be corrected 

using a Damping Coefficient . 
 
Following Eurocode 8 [6], this coefficient is calculated as follows: 

 
10

0,55
5




 


        (4.13) 

Where   = Damping Ratio expressed in percent 
 

For a default damping ratio of 5%,  equals unity.  
 
 

The lower limit of 0,55 for the Damping Coefficient indicates that Damping Ratio’s higher than  
28.06% have no further influence on the seismic spectrum. 

For the exact application of  in the formulas of the seismic design spectra, reference is made to 
Eurocode 8 [7]. 
 
In this example, the damping ratio of 2% causes the following Damping Coefficient: 

 
10

5 2
  


1,1953 

 
 

This indicates that the spectral accelerations will be augmented by 20% due to the fact that less 
damping is present in the structure. The spectral accelerations of the previous example can thus be 

multiplied by : 

               
 

  
              

 

  
   

               
 

  
              

 

  
 

 
 
With these new spectral accelerations, the calculation of the Base Shear, Overturning Moment,… can 
be repeated. 
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Manual Calculation 

In this paragraph, the application of the CQC-method is illustrated for the global response of the Base 
Shear. 

 Mode 1: (1) = 3,3027 rad/s F(1) = 0,8951 kN 

 Mode 2: (2) = 21,6256 rad/s F(2) = 1,9258 kN 
 

Using a spreadsheet, the Modal Cross Correlation coefficients i,j are calculated with a damping ratio 

i,j of 2%. 
 

Mode 1 2 

1 1 0,0003065 

2 0,0003065 1 
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4.3 Seismic Combinations 

There are different possibilities to create load combinations which include also seismic load cases.  
Since SCIA Engineer 14, there is an optimal possibility available due to some changes in seismic 
combinations. This is also linked to the following message which is displayed when opening an older 
project with dynamic functionalities activated in it: 

 

Example 4-4: Spectral_Analysis_4_Combs.esa 

First of all, 3 load cases are created.  
The general format of effects of actions should be:  

, 2, ,; ; ;  j 1;i 1d k j Ed i k iE E G P A Q    

The combination of actions in brackets can be expressed as: 

, 2, ,

1 1

'' '' " " " "k j ED i k i

j i

G P A Q
 

     

 

:Where 

0,3 0,3

0,3 0,3

0,3 0,3

d

Edx Edy Edz

Edx Edy Edz

Edx Edy Edz

E

E E E

E E E

E E E

 

 

 

 

 
So, these load cases include respectively the seismic spectra in the directions X, Y and Z.  
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For example: 

 
 
Please note that a different Eurocode must be generated for the vertical direction. In SCIA Engineer, a 
load case must be made for component of the earthquake in the X-direction, another for the Y-
direction, and another for the Z-direction. 
 
Please make sure that the ‘factor’ just underneath the spectrum is not set to ‘zero’, since the 
accelerations in the seismic spectrum will be multiplied with this value. 
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Next, we have to assign a type of load group to the seismic load case. 
 
First of all, the relation between load cases in the same group has to be defined. The three seismic 
spectra have to appear always in the same combination. So, the option ‘together’ will be chosen here.   
Next, the type of load has to be selected: for this, the special type ‘seismic’ has been implemented.  
 

 
 
 
After the creation of seismic load cases, the combinations can be made. For this purpose, a new type 
of combinations was implemented: namely the Seismic combination according to the EC-EN.  
To use this special type of combination, the seismic load cases must have a load group with properties 
‘seismic’ and ‘together’ assigned to it. Also no active coefficients can be used. 

 
 
This combination will automatically look at the seismic load cases with both a positive and a negative 
coefficient, and will automatically make one of the seismic load cases the primary load case and the 
others secondary load cases. 
 
If we would not yet take into account that the coefficients can be both positive and negative, then an 
example would be: 
 

0,3 0,3

0,3 0,3

0,3 0,3

 

 

 

Edx Edy Edz

Edx Edy Edz

Edx Edy Edz

E E E

E E E

E E E
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Note: 
______________________________________________________________________ 
In the case of the EC-EN, we have to make two sets of combinations, one for the deformations and 
one for the internal forces. This means that we would have in total 6 EN-Seismic load cases. For 
internal forces, the load cases have to be introduced as described above. For deformation results, we 
must create 3 new load cases, which have a behavior factor q equal to 1.0. 
 
If we consider our example with a q factor of 1.5, we would have to copy the existing seismic load 
cases, and give the new load cases new spectra with a behavior factor q set to 1,0. 
 

 
 
Then all you have to do, is make a new seismic combination with the new load cases. 
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4.4 Mass in Analysis 

As mentioned before, the sum of the effective modal masses for the modes taken into account must 
amount to at least 90%. The user can try to achieve this with the following possibilities: 

- Take more natural frequencies into account. 

- Assign mass more to nodes/connection instead of beams (to avoid local eigenmodes). 
 
The mass which has not been taken into account (for example, if the effective modal mass is 90%, 
then there is 10% not taken into account), can be treated in 3 possible different ways in SCIA Engineer: 
 

 
 
The used method is set in each seismic load case and is again displayed in the linear calculation 
protocol. Let’s take as example that the effective modal mass in a direction is 90%. Then how can the 
other 10% be treated? 

- Participation mass only: In this case, the 10% would be ignored. We would only take into 
account 90% of the mass of the structure to calculate the effects of an earthquake. 

- Missing mass in modes: In this case, the missing mass would be divided over the calculated 
modes. Which means the 10% would be distributed over the eigenmodes which make up for the 
90% which we did find. This is done according to their weight. So for the calculation of internal 
forces and deformations, the masses in the calculated modes would be increased by 100%/90% 
= 1,111… 

- Residual mode: In this case, a ‘fictual’ mode corresponding to the combination of all missing 
modes can be calculated. But since these missing modes are over different natural frequencies, 
the last found frequency will also be the natural frequency of this mode. In the calculation, the 
forces in this mode will be calculated in the same way as in the other modes. 

 
A detailed explanation of these modes by using examples can be found in Annex D. 
 

4.5 Modal superposition 

 
The response spectrum method uses a modal superposition of the relevant eigenmodes of the structure. The 
methods which are used for modal superposition are the ones described at the beginning of the chapter: 
SRSS or CQC. 
 
These methods have the advantage of very easily providing design values of all results (displacements, 
internal forces…) but only part of the information is available: 

 min and max values of any result can be determined 

 the actual sign of a result cannot be defined 

 the concomitance of separate results cannot be defined 
 
 
The loss of concomitance and sign of results is an issue typically when computing resulting forces in shear 
walls: it is not possible to compute a resultant from internal forces after modal superposition, as typically all 
raw results are positive. 
Computing resultant forces in one of those shear walls would typically give near-zero moments and 
extremely overestimated axial forces. 
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In SCIA Engineer 2013 and higher, an automatic method can be used since using signed results 
(described below) is only a workaround to obtain usable resulting forces. 
 
The rigorous method for computation of resultants in the context of the response spectrum method can be 
summarized as follows: 

 compute the local internal forces for each eigenmode 

 compute the resultant force for each eigenmode separately 

 apply the modal superposition to the obtained modal resultant values 
 
 
 
When proceeding so, no result signature is necessary to obtain correct values of resulting forces. Moreover 
there are cases where the method described in the previous paragraph gives overestimated results of most 
result components and can therefore only be seen as an approximation. The method described here is 
clearly more accurate. 
 
 
Since version 2013, this option is enabled by default for new projects in SCIA Engineer. For old 
projects, you have to open the Solver > Setup and activate it: 
 
 

 
 
 
 
 
To obtain usable values of resulting forces, a possibility is the so-called “signed results” method. 
It consists of applying some signature scheme to raw results of the modal superposition. A classical 
approach uses the sign of the most significant eigenmode.  
 
It is however very important to know that this method will only give good result if there is 1 and only 1 
eigenmode of great importance in that respective direction (compared to the other eigenmodes). 
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Applying this to shear walls, it is possible to “sign” the internal forces, making them suitable for computation 
of resulting forces. 
 
You can sign results in SCIA Engineer by selecting a signature mode manually or a default mode determined 
by the program. If the Automatic is chosen, the mode shape with the biggest mass participation is used (sum 
of direction X, Y and Z): 
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5. Damping 

 
In the previous chapters, the influence of damping on the dynamic response of a structure was shown. 
Especially in the vicinity of resonance the effect of damping was significant. 
In this chapter, damping will be looked upon in more detail. First the theory will be explained after 
which the input of non-uniform damping in SCIA Engineer is regarded. 
By means of the examples of the previous chapter, the influence of damping on the seismic response 
is illustrated. The chapter is finished with a 3D structure, which takes into account material damping of 
the different elements. 
 

5.1 Theory 

Damping can have different causes. The component that is always present is structural damping. 
Structural damping is caused by hysteresis in the material: the transfer of small amounts of energy into 
warmth for each vibration cycle possibly increased by friction between internal parts.  
Other causes can be the foundation soil of the building and aerodynamic damping due to the diversion 
of energy by the air [22]. In many cases, damping is increased by adding artificial dampers to the 
structure. 
 
In the same way as for the previous chapters, first the theory is examined. A complete overview can be 
found in reference [1]. 
 
Consider the following damped free-vibrating system: 

 
A body of mass m can move in one direction. A spring of constant stiffness k, which is fixed at one 
end, is attached at the other end to the body. The mass is also subjected to damping with a damping 
capacity c. 
 
The equation of motion, using matrix notations can be written as: 

0)()()( 


txKtxCtxM      (5.1) 

 
A possible solution to this equation is one of the type: 

steAx           (5.2) 

 
Substituting (5.2) in (5.1) gives: 

02  ststst eAKeAsCeAsM    

 (5.3) 
 
This equation can be rewritten as: 

02 22  nsns        (5.4) 

With: 
M

C
n

2
         (5.5) 
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k
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M

K
n          (5.6) 

The possible solutions for equation (5.4) are: 

22

nnns         (5.7) 

It is clear that the response of the system depends on the numerical value of the radical. Therefore the 
following three possibilities need to be examined: 

nn   

nn           (5.8) 

nn   

 
These can be rewritten as: 

MKC  2  

MKC  2         (5.9) 

MKC  2  

 

The condition cCMKC  2  is called critical damping. In this case, the displaced body 

is restored to equilibrium in the shortest possible time, without oscillation. 

The ratio 

cC

C
  is called the damping ratio or the relative damping. 

Therefore, when assuming nn   , equation (5.5) can be written as: 

MC n  2         (5.10) 

The three possibilities of equation (5.8) can then be rewritten as: 

1   

1              (5.11) 

1   

 

When looking at the conditions 1  and 1 , it can be shown that there is no harmonic 

solution. Only the condition 1  gives a harmonic solution. 

 

Introducing the damped circular frequency 
21   nD , the solution to equation (5.1) 

can be written as: 

    tBtAex DD

tn 
sincos 


     (5.12) 

 
In chapter 2 this vibration equation was illustrated by the following figure: 
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A convenient way to determine the damping in a system was shown to be the logarithmic decrement 

 , which is the natural logarithm of the ratio of any two successive amplitudes in the same direction.  

2
11

1

1

2
ln








X

X
        (5.13) 

Note: 

As shown above, the circular frequency is reduced by the damping action to obtain the damped circular 

frequency. However, in many systems this reduction is likely to be small because very small values of  

are common; for example, in most engineering structures  is rarely greater than 0,02. Even if  = 0,2; 

D=0,98n 

 
Annex B gives some references for numerical values of the damping ratio. 
 

5.2 Damping in SCIA Engineer 

In SCIA Engineer, damping can be specified on 1D elements, 2D elements and supports. The damping 
of each of these elements (or substructures) will be used to calculate a modal damping ratio for the 
whole structure for each Eigenmode. In the literature this is described as Composite Damping. 
Composite damping is used in partly bolted, partly welded steel constructions, mixed steel-concrete 
structures, constructions on subsoil, ... 
For structural systems that consist of substructures with different damping properties, the composite 

damping matrix C  can be obtained by an appropriate superposition of damping matrices iC for the 

individual substructures: 





N

i

iCC
1

          (5.14) 

With: iC = The damping matrix for the i
th
 substructure in the global coordinate  

 system. 
 N = The number of substructures being assembled. 

 

Proportional Damping (Rayleigh Damping) 

A way of describing the damping is assuming that the damping matrix is formed by a linear 
combination of the mass and stiffness matrices. 

iiiii KMC          (5.15) 

 

With: i and i = Proportional damping coefficients for the i
th
 part of the structure. 

Mi = Mass matrix for the i
th
 part of the structure in the global coordinate  

  system. 
Ki = Stiffness matrix for the i

th
 part of the structure in the global coordinate  

 system. 
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Formulas for these proportional damping coefficients can be found in reference [19]. 
Examples can be found in reference [20]. 
 

Stiffness-Weighted Damping 

For structures or structural systems that consist of major substructures or components with different 
damping characteristics, composite modal damping values can be calculated using the elastic energy 
of the structure [8], [21]: 

E

E
N

i

ii

j






 1



         (5.16) 

With:  j   = Damping ratio of the considered eigenmode. 

E   = Elastic energy of the structure, associated with the modal displacement of the 
considered eigenmode. 

N   =  The number of all substructures. 

i   = Damping ratio for the i
th
 substructure. 

iE   =  Elastic energy for the i
th
 substructure, associated with the modal 

displacement of the considered eigenmode. 
 
Equation (5.16) can be rewritten in the following way [19]: 

 

2

1

j

j

N

i

i

T

j

j

K






















       (5.17) 

With:   iK = Stiffness matrix for the i
th
 substructure in the global coordinate system, 

scaled by the modal damping ratio of the i
th
 substructure. 

 

Note: 

This formula may be used as long as the resulting damping values are less than 20% of critical. If 
values in excess of 20% are computed, further justification is required. 

 
As specified, in SCIA Engineer on each element a damping ratio can be inputted. For this ratio, also 
the damping of the material can be used from which the element is manufactured. 
 
When no damping ratio is inputted on an element, a default value will be used since all elements need 
a damping ratio before the above formulas can be applied. The input of this default will be shown in the 
examples.  
Analogous to the input of other objects in SCIA Engineer, Damping on elements will be grouped in a 
Damping Group. In turn, this Group can be assigned to a Combination of Mass Groups.  
 

Support Damping 

Additional to the damping of 1D and 2D elements, SCIA ENGINEER allows the input of a damper on a 

flexible nodal support. The modal damping ratio j  is calculated by the following formula: 

j

js

s

s

T

js

j

C

Alpha



















4

,,

      (5.18) 

  With: j  = The circular frequency of mode j 

js, = The modal displacement in support node s for mode j 

sC = The damping constant for the support 

Alpha = A user defined parameter (> 0) 
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The total modal damping ratio can then be calculated as the summation of equations (5.17) and (5.18). 
As specified, on all 1D and 2D elements a damping ratio has to be defined. This is not the case with 
supports, not every support needs to have a damping value. 
 
The following diagram shows how non-proportional damping is inputted in SCIA Engineer: 
 

 
The use of dampers and the calculation of the composite damping ratio will be illustrated in the 
following examples. 
 

Example 5-1: Damping_1.esa 

In this example, the principle of stiffness-weighted damping is illustrated. 
A concrete frame is modeled in which the beam is assumed to be rigid. In this case, only the columns 
take part in the horizontal stiffness of the frame. 
The left column has a Rectangular 500 x 500 section, the right column a Rectangular 350 x 350 
section. The column bases are modeled as rigid. To model the rigid beam, a Rectangular 500000 x 
500000 section is used. To make sure this beam acts as rigid, in the nodes between the columns and 
the beam, supports are inputted which have a fixed Translation Z and Rotation Ry. The height of the 
columns and the length of the beam are taken as 5m. All elements are manufactured in C30/37 
according to EC-EN. 

 Activate the functionalities     - Dynamics 

   - Non-Proportional Damping 

Create a Damping Group 

Input Dampers 

Assign the Damping Group to a Mass Combination 

Proceed with the steps of the previous chapters 
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The beam is loaded by a line mass of 500 kg/m. The left column has a damping ratio of 12%, the right 
column a damping ratio of 3%. 
One static load case is created: the self-weight of the beam. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of C30/37 can be set to 1e-10 
kg/m³ in the Material Library. This low value is chosen to avoid any influence by the rigid beam. 
The steps of the Free Vibration calculation are followed and extended with the input of damping. 
 

Step 1: Functionality 

The first step in the Dynamic calculation is to activate the functionalities Dynamics and Non-
Proportional Damping on the Functionality tab in the Project Data. 
 

 
  



Vortex Shedding: Karman Vibration 

109 

Step 2: Mass group and masses 

A Mass Group is created after which the line mass of 500 kg/m can be inputted on the rigid beam. 

 

Step 3: Damping 

Before creating a Combination of Mass Groups, the dampers are inputted. 
 

 
 
First of all, a Damping Group is created. 
 

 
 
As specified in the theory, on each element a damping ratio needs to be inputted. When no damper is 
specified, a default value will be taken. In the properties of the Damping Group, this default can be set 
as either: 
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- Global default: The logarithmic decrement specified in the Damper Setup will be used 
- Material default: The logarithmic decrement of the material will be used 

 
 

In this example, the Global default is chosen. 
After the creation of a Damping Group, Dampers can be inputted. In this example, 1D Damping shall 
be inputted on the columns. The damping can be inputted in the following ways, which have been 
explained in the theory: 

 
 
 
On the left column, a Relative damping of 0,12 is inputted, on the right column a Relative damping of 
0,03. 

 
 
 
As a final step, the general parameters can be checked through Damper Setup: 
 

 
 
The Base value specifies the default value when a Damping Group of type Global default is chosen 
and no damper is inputted on an element. 
The Alpha factor is used in the damping calculation for supports as specified in the theory. 
When the composite modal damping ratio is calculated, the value is checked with the Maximal modal 
damping value inputted here. If the calculated value is higher than the maximal value, the maximal 
value is used. In this example, the maximal value is set to 0,2 in accordance with the remark for 
formula (5.17) 
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Step 4: Mass matrix 

A Combination of Mass Groups can now be created and the Damping Group can be specified. 
 

 

Step 5: Mesh setup 

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined. 
This can be done through Calculation, Mesh > Mesh Setup. 
 

 
 
The Average number of tiles of 1D element is set to 10. 
 

Step 6: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be calculated. 
For this example, only one eigenmode is required so in Calculation, Mesh > Solver Setup the 
number of frequencies is set to 1. 
To compare the results with a manual calculation, the shear force deformation is neglected. 
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Step 7: Calculation 

All steps have been executed so the Free Vibration calculation can be started through Calculation, 
Mesh > Calculation. 
 
The following results are obtained through the Calculation Protocol for the Eigen Frequency 
calculation: 
 

 
 
The calculated modal damping ratio is shown to be 0,1026 or 10,26%. 
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Manual Calculation 

In order to check the results of SCIA Engineer, a manual calculation is performed. 
First, the calculated eigen frequency is checked using formula (2.3) 
In this example, the two columns can be treated as fixed-fixed beams. Using default engineering tables 
[12], each column contributes the following stiffness to the frame: 

3

12

L

EI
k           (5.19) 

 
With: Column 1:  
   E = 32000 N/mm² 
   I = 5208300000 mm

4
 

   L = 5000 mm 
Column 2:  

E = 32000 N/mm² 
   I = 1250500000 mm

4
 

   L = 5000 mm 

mm
N

mm

mm
mm

N

k 8976,15999
)5000(

52083000003200012

3

4
2

1 


  

mm
N

mm

mm
mm

N

k 536,3841
)5000(

12505000003200012

3

4
2

2 


  

 
Both columns act in parallel since each column will displace the same amount due to the fact the beam 
is rigid. The beam itself does not bend so it does not contribute to the stiffness. 

mm
N

mm
N

mm
Nkkktot 4336,19841536,38418976,1599921   

 
The vibrating mass is calculated as: 

kgm
m

kg
25005500   

s
rad

kg

m
N

m

k
087,89

2500

6,19841433
  






2
f 14,1787 Hz 

These results correspond exactly to the results obtained by SCIA Engineer.  
 
Next, the stiffness-weighted damping ratio is calculated. The first column has a damping ratio of 12%, 
the second column a damping ratio of 3%.  
Using the elastic energy principle of formula (5.16) the modal damping ratio can be calculated as 
follows: 

mm
N

mm
N

mm
N

k

kk

tot 4336,19841

536,384103,08976,1599912,0
2211








  

  0,1026   10,26% 
 
This result corresponds exactly to the result obtained by SCIA Engineer. 
The modal damping ratio can now be used to calculate the Damping Coefficient in a seismic 
calculation. This will be illustrated in the following examples. 
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Example 5-2: Damping_2.esa 

In this example, non-proportional damping is accounted for in a seismic calculation using the SRSS 
modal combination method. To this end, the example Spectral_Analysis_2.esa from the previous 
chapter is extended with dampers. 
More specifically, a relative damping of 12%, 3% and 8% is inputted on the three columns starting from 
the base of the structure. 
 

Step 1: Functionality 

The first step to take into account the damping is to activate the functionality Non-Proportional 
Damping on the Functionality tab in the Project Data. 
 

Step 2: Damping group 

The second step is the creation of a Damping Group. 
 

 
 
Since a damper will be inputted on all elements, the choice of the default damping type is not relevant. 
 

Step 3: Dampers 

After the creation of a Damping Group, Dampers can be inputted. A relative damping of 12%, 3% and 
8% is inputted on the three columns starting from the base of the structure: 
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Step 4: Mass matrix 

As a final step, the Damping Group is assigned to the Mass Combination: 

 
 
The non-proportional damping has now been inputted so the Linear Calculation can be re-done to 
see the Seismic results. 
The following results are obtained through the Calculation protocol of the Linear Calculation: 
 

 
 
For both eigenmodes the Composite Modal Damping Ratio is calculated using equation (5.17). 
As specified in the previous chapter, this Damping Ratio will be used to calculate the Damping 
Coefficient, which influences the spectral accelerations. Using equation (4.13): 

 1

10

5 9,96
  


0,8176 

 2

10

5 7,11
  


0,9087 

 
As expected, since the modal damping ratios are higher than the default 5% used in the acceleration 
spectrum, they will have a positive effect thus lowering the response of the structure. 
More specifically, for the first eigenmode only 81,7% of the spectral acceleration will be taken into 
account and for the second eigenmode 90,8%. 
 

The spectral accelerations of the original example without damping can thus be multiplied by : 

2 2,(1) 0,2019 0,8176 0,1651ax
m mS

s s
     

2 2,(2) 0,4380 0,9087 0,3980ax
m mS

s s
     

 
These adapted spectral accelerations will thus influence the mode coefficients, the base shear, the 
overturning moment, the nodal displacements and accelerations,… 
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Example 5-3: Damping_3.esa 

In this example, non-proportional damping is accounted for in a seismic calculation using the CQC 
modal combination method. To this end, the example Spectral_Analysis_3.esa from the previous 
chapter is extended with dampers. 
More specifically, a relative damping of 2%, 5% and 2% is inputted on the three columns starting from 
the base of the structure. 
As seen in the theory and the original example, the CQC method required the definition of a Damping 
Spectrum. This damping spectrum was used for the calculation of the Modal Cross Correlation 
Coefficients and to calculate the Damping Coefficient for each mode. 
When however Non-Proportional Damping is used, the calculated Composite Modal Damping Ratios 
are used instead of the data of the Damping Spectrum. This is illustrated in this example. 
 

Step 1: Functionality 

The first step to take into account the damping is to activate the functionality Non-Proportional 
Damping on the Functionality tab in the Project Data. 
 

Step 2: Damping group 

The second step is the creation of a Damping Group. 

 
 
Since a damper will be inputted on all elements, the choice of the default damping type is not relevant. 
 

Step 3: Dampers 

After the creation of a Damping Group, Dampers can be inputted. A relative damping of 2%, 5% and 
2% is inputted on the three columns starting from the base of the structure: 
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Step 4: Mass matrix 

As a final step, the Damping Group is assigned to the Mass Combination: 

 
 
The non-proportional damping has now been inputted so the Linear Calculation can be re-done to 
see the Seismic results. 
The following results are obtained through the Calculation protocol of the Linear Calculation: 
 

 
 
In the original example, a Damping Spectrum with a constant damping ratio of 2% was used. Due to 
the inputted dampers, the calculated Composite Modal Damping Ratios of 2,64% and 3,30% are now 
used. 
Using equation (4.13) the Damping Coefficients can be calculated: 

 1

10

5 2,65
  


1,1432 

 
2

10

5 3,30
  


1,0976 

As was the case in the original example, the damping ratios are lower than the default 5% used in the 
acceleration spectrum, they will have a negative effect thus augmenting the response of the structure. 
Since the calculated damping ratios are higher than the original 2%, the response will be less when 
compared to the original example. 
Second, the calculated Composite Modal Damping Ratios will be used for the calculation of the Modal 
Cross Correlation Coefficients of the CQC-method. 
This will be illustrated in a manual calculation. 
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Manual Calculation 

In this paragraph, the application of the CQC-method using the calculated Composite Modal Damping 
Ratios is illustrated for the global response of the Base Shear. 

 Mode 1: (1) = 3,3007 rad/s F(1) = 0,2701 kN 

 Mode 2: (2) = 21,5192 rad/s F(2) = 0,1629 kN 
 

Using a spreadsheet, the Modal Cross Correlation Coefficients i,j are calculated with a damping ratio 

i,j of 2,64% for the first eigenmode and 3,30% for the second eigenmode.  
 

Mode 1 2 

1 1 0,00055202 

2 0,00055202 1 

 

kN

kNkNkNkN

kNkNkNkN

RRR
N

i

N

j

jjiitot

315,0

1875,011629,02701,000055202,01629,0

1629,000055202,02701,02701,012701,0

1 1

)(,)(








 
 



 

 
The difference between these Correlation Coefficients and the original is very small which was to be 
expected since the calculated damping ratios are close to the original 2%. 
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Example 5-4: Damping_4.esa 

In this example, a seismic analysis is carried out on a storage depot. The layout of the structure is 
given in the pictures below. The depot is constructed with steel members manufactured of S235 
according to EC-EN. On the upper roof, a steel shell is used with thickness 20 mm. 
On each floor level, concrete slabs are used with thickness 200 mm. The slabs are manufactured in 
C25/30 according to EC-EN. 
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The diagonals are hinged in both directions. The column bases are also hinged though the anchors 
are spaced such that the rotation around the Z-axis is taken as fixed. 
The steel members of the depot have following cross-sections: 

- Columns: IPE 300 
- Floor Beams: HEA 200 
- Roof Beams: IPE 160 
- Diagonals: L(ARC) 40x40x4 

 
The vertical loads acting on the structure are: 

- Load Case 1: The self-weight of the depot 
- Load Case 2: A category E (Storage) imposed load of 5 kN/m² on all floor slabs. 

 
The structure will be subjected to an earthquake loading in both X, Y and Z direction, using a Design 
Response Spectrum according to Eurocode 8 for Ground Type A with a behavior factor of 1,5. This 
means that the spectrum for the internal forces will be divided by this value. The acceleration 
coefficient is 0,50. 
For the dynamic calculation, the structural damping of the depot is taken into account. More 
specifically, a logarithmic decrement of 0,025 is used for steel and 0,056 for concrete [22]. 
 

Step 1: Functionality 

The first step in the Seismic calculation is to activate the functionalities Dynamics and Seismic on the 
Functionality tab in the Project Data. In order to take the structural damping into account, the 
functionality Non-Proportional Damping is also activated. 
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Step 2: Masses & Mass groups 

The second step is to create Mass Groups and then the creation of Masses. 
Since the self-weight is automatically taken into account in a Combination of Mass Groups, only one 
Mass Group is created here, a group to take the mass of the imposed load into account. 
 

Using the action  automatically generates masses from the already inputted 
loads. 

 
 

Step 3: Damping groups 

Before creating a  
Combination of Mass Groups,  
the damping is specified. 
 
First of all, a Damping Group is 
created. 
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Since, in this example, the structural damping of the steel and concrete is taken into account, the Type 
of default damping is set to Material default. This way, when no damper is inputted on an element, the 
default damping value of the material will be used. 
The damping values can be specified in the Material Library: 
 

 
 
For the concrete, a logarithmic decrement of 0,056 is inputted, for the steel a value of 0,025. 
 

Step 4: Mass matrix 

The Mass Group and Damping Group can now be combined in a Combination of Mass Groups. 

As specified in formula (2.9) all gravity loads appearing in the following combination of actions need to be 

taken into account for an eigenmode calculation: 

   ikiEk QG ,,  

For this example, with a Category E imposed load,  is taken as 1,0 and 2,i as 0,8. This gives a value 

of 0,8 for E,i 

Since the Self-Weight is automatically taken into account, the Combination of Mass Groups CM1 can 
be formulated as 0,80 MG1  
 

 
 
As a final step, the Damping Group is assigned to the Combination of Mass Groups. 
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Step 5: Seismic spectrum 

Before creating the Seismic load cases, the Seismic Spectrum needs to be defined through Libraries 
> Seismic Spectrums. 
Instead of inputting a spectrum manually, the spectrum according to EC8 is chosen. In this example, 
the spectrum for Ground Type A with a Behavior Factor q = 1,5 is used for all directions: 

 
 

Step 6: Seismic load case 

The Seismic load cases can now be defined through Load cases, Combinations > Load Cases. 
For the Seismic load case in the X-direction, the following parameters are used: 
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The Coefficient of Acceleration is set to 0,5. As Type of evaluation the CQC-method is used. 
 
In exactly the same way, the Seismic load cases in the Y and Z-direction are defined: 
 
Note: 

 
- For the load case Seismic Z a new spectrum has to be defined with type vertical. 
- 3 other EN-Seismic load cases have to be defined, the first 3 are for internal forces and 3 new 

(with q-behavior factor set to 1) for deformation. Each group of load cases has to get a load 
group with type “seismic” & “together” and they must be placed in separate combinations. 

 

 
 
According to Eurocode 8 [7] the action effects due to the combination of the horizontal components of 
the seismic action may be computed using both of the two following combinations: 

 

" "0,3 " "0,3

0,3 " " " "0,3

0,3 " "0,3 " "

 

 

 

Edx Edy Edz

Edx Edy Edz

Edx Edy Edz

E E E

E E E

E E E

 

       
Where: 

""  = Implies “to be combined with”. 

EdxE  = Represents the action effects due to the application of the seismic action along the 

chosen horizontal axis x of the structure. 

EdyE  = Represents the action effects due to the application of the same seismic action along 

the orthogonal horizontal axis y of the structure. 

EdzE  = Represents the action effects due to the application of the same seismic action along 

the orthogonal vertical axis z of the structure. 
 
First of all, this implies that all Load cases must always be considered together in a combination. In 
SCIA Engineer this can be done by putting both Seismic Load cases in a Load Group with relation 
Together. 

 

Note: 

The EC1 – load type will not be used in this example. In the new EC-EN it is possible to specify the 
load type as Seismic. 

 
Next, the combination for the Seismic calculation can be inputted. According to Eurocode 8 [7] this 
combination is the following: 

    ikiEdk QAPG ,,2        (5.22) 

 
Where Aed signifies the accidental action, in this case the combined seismic action. 
In SCIA Engineer, the ‘EN-seismic’ type can be used for this purpose.  
To fulfill the conditions of the Eurocode, 6 load combinations of this type are created: 
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Step 7: Mesh setup 

To obtain precise results, the Finite Element Mesh is refined through Calculation, Mesh > Mesh 
Setup.   The Average number of tiles of 1D element is set to 10; the Average size of 2D element is 
set to 0,25m. 
 

 
 

Step 8: Solver setup 

The last step before launching the calculation is setting the amount of eigenmodes to be calculated. 
For this example, five eigenmodes are chosen. 
In Calculation, Mesh > Solver Setup the number of frequencies is thus set to 5. 
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Step 9: Calculation & Results 

All steps have been executed so the Linear Calculation can be started through Calculation, Mesh > 
Calculation. 
 
The Calculation Protocol for the Eigen Frequency calculation shows the following: 

 
 
It can be seen that for both horizontal directions more than 90% of the total mass is taken into account 
in these five modes so it is concluded that sufficient Eigenmodes have been calculated. 
Through Deformation of nodes under 2D Members, the Deformed Mesh can be used to visualize 
the first four Eigenmodes: 
 

       
Eigenmode 1: f = 0,73 Hz     Eigenmode 2: f = 1,82 Hz 
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Eigenmode 3: f = 2,17 Hz     Eigenmode 4: f = 2,20 Hz 
 
 
The Calculation Protocol for the Linear calculation shows the results of the seismic calculation: 

 
 
For each Eigenmode the Composite Damping Ratio has been calculated using the structural 
damping of the steel and concrete. 
 
The combinations can now be used to verify the structural elements. 
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6. Reduced Analysis Model 

6.1 Theory 

The actual tendency in FE structural analysis is using full 3D modelization of the considered structure. 
SCIA Engineer obeys that rule as structures are usually modeled in 3D using beam and shell elements, 
including buildings. 
 
Once a detailed 3D model is ready for statical analysis of a structure, it is natural to use it also for 
dynamic analysis and, more specifically, for seismic design. A typical issue of full 3D model is, that 
seismic design regards mostly the global behavior of the structure whence the full mesh of the 
structure provides a lot of information about local behaviors. When performing the modal analysis, the 
full mesh finds all local and global vibration modes, but the local modes are irrelevant for the overall 
seismic response of the structure. It appears hence logical to use a different, reduced mesh for the 
dynamic analysis, which ignores these local modes. 
 
There are well known matrix condensation techniques (Guyan Reduction, also known as static 
condensation) which allow the user to obtain a reduced system in a very efficient way, but those 
methods are not well suited for dynamic analysis. An Improved Reduced System (IRS) method has 
been developed which takes into account not only the stiffness matrix of the system, but also the mass 
matrix during the condensation process. That method proved to give excellent results for dynamic 
analysis, with both modal analysis and direct time integration methods. 
 
The algorithm implemented in SCIA Engineer uses the IRS method and consists of 3 steps: 
 
1. The IRS method is used for condensing the mesh of the analysis model. 
2. The modal analysis is performed using the reduced mesh, which has typically 1’000 times less 
degrees of freedom than the original full mesh. This makes the calculation of eigenvalues massively 
faster on large structures and also avoids unwanted local modes. The latter is particularly interesting 
for seismic analysis. 
3. The results of the reduced system are expanded to the original full mesh, allowing for output of 
detailed results in the entire structure. 
 

Full 3D Storey-based input Condensed model & 
dynamic analysis 

Expand back to full mesh for 
result input 
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The IRS method allows: 
 

1. Elimination of irrelevant, local bending vibration modes in the slabs: local modes in all 
structural elements are implicitly removed, due to the elimination of unwanted degrees of freedom. 
Of course, adding more reduction nodes would allow for more detailed analysis of local modes, but it 
is particularly interesting for seismic analysis to keep in the reduced model only the nodes that are 
strictly necessary to reproduce the typical seismic behavior of a building. Ultimately, it is up to the 
user to choose the reduction points in such a way that the wanted eigenmodes are obtained. 

2. Reduction of computation time: the computation time is reduced, due to the drastic reduction of 
the number of degrees of freedom; actually, the reduction is even more important than with 
diaphragms, as supporting members are also condensed. 

3. Easy handling of mass eccentricities for each deck: the IRS analysis uses a full mass matrix, 
which allows for exact implementation of mass eccentricity in each node of the reduced system. 

 
Remark:  The elimination of unwanted frame effects from the structural behavior (considering deck 
slabs as diaphragms) is not addressed by the IRS analysis in itself, as it does not modify the 
mechanical behavior of the structure. However, as unwanted local bending modes are implicitly 
removed from the reduced system, so-called flexible diaphragms may be easily simulated by 
significantly reducing the bending stiffness of deck slabs. Not only does that allow obtaining classical 
diaphragm behavior by means of a very low bending stiffness, but also intermediate behavior where 
the bending stiffness is less drastically reduced and frame effects are therefore reduced, but not 
completely removed. 

 
The condensed model is obtained from Reduction nodes. R-nodes are placed in each storey, at the specified 
level, in the middle of the structure (all R-nodes are located on the same vertical axis). 
 
During the analysis, the reduced model is automatically generated from the full mesh of the structure. Each 
node of the full mesh is mapped to the closest R-node. In a typical building configuration, this means that 
each R-node will receive the stiffness, loads and masses from the corresponding deck slab, from the top half 
of the supporting members below the slab and from the bottom half of the supporting members above the 
slab. 
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Unlike the classical modal analysis, which typically uses a lumped mass matrix (only diagonal terms 
are non-zero), the reduced system uses a full mass matrix , with non-zero values out of the diagonal. 
This means that mass eccentricities can be taken into account easily by the reduced system. The very 
small size of the reduced system allows using the full mass matrix. 
 
Therefore the reduction points – or so-called R-nodes – that will constitute the reduced model do not 
need to be located in a particular position, such as the mass center of each storey. As the structure 
may have to be calculated several times with various distributions of the masses, the mass center of 
each storey is likely to be slightly different depending on the selected mass combination. Thanks to the 
use of a full mass matrix, the same R-nodes may be used in all cases. 
 
During the analysis, the reduced model is computed automatically from the full mesh. Each node of the 
full mesh is mapped to the closest R-node of the reduced model. 
 

6.2 IRS Method in SCIA Engineer 

 
To make an IRS calculation, you have first to perform all the steps as described in detail for seismic 
calculation in previous chapters. As a reminder, those steps are: 
 

 
 

 Activate the functionalities     - Dynamics 

- Seismic 

Input Masses Generate Masses from Static Load cases 

Create a Mass Group 

Create a Mass Combination 

Perform a Linear Calculation 

Refine the Finite-Element Mesh if required 

Specify the number of Eigenmodes to be calculated 

Create a Seismic Load case 

Define a Seismic Spectrum 
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Before doing the linear analysis, the additional steps you have to execute in order to make an IRS 
calculation are: 
 

1.  You have to enable the reduced model analysis in the project. This can be done via Setup menu > 
Solver: 

 
 

 
 

2. Define the building storeys. The Reduction nodes will be calculated from the storey data. In SCIA 
Engineer 2013, each storey is reduced into one R node.  

 

 
 
 
To introduce the building storeys, go to Main menu > Line grid and storeys > Storeys: 
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The storey manager where you can input the levels opens: 
 
 

 
 
 
With the default settings, the deck slab of each storey is located at the bottom of the storey, and so is 
the corresponding R-node. It is recommended to keep it that way. This can be seen from the storey 
Properties: 
 

 
 
 
 

3. Once the linear calculation has been executed, results are available. There are fundamentally two 
types of results available after an IRS analysis: 

 The results of the reduced model are automatically expanded to the original mesh and are 
accessible through standard output. This will not be detailed here as it is the same as what 
has been explained in the previous chapters. 
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 Some dedicated results, coming directly from the reduced model, are available in the new 
result service Results menu > Storeys > Summary Storey Results. This typically gives 
information about the masses, displacements and accelerations at each storey in the reduced 
model. 

 Other results can be displayed via Results menu > Storeys > Detailed Storey Results: this 
menu can be used to display results from the full mesh analysis. It may be used for results 
from any linear analysis, with or without dynamic analysis, with or without IRS analysis. It 
provides results in all supporting members, with easy selection of members per storey. Walls 
and columns may be represented on the same drawing. Typical provided results are: internal 
forces, resultants per wall or per storey… 
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Example 6-1: IRS_1.esa 

Open the project IRS.esa 
We are going to apply the principles seen above to this small building. 
 

Step 1: Set up the seismic model 

 Activate Dynamic and Seismic functionalities from the Project data menu. 
 

 
 

 Create mass groups. For this example we are going to consider 3 mass groups related to 3 static 
predefined load cases : self weight, Dead Load (DL) and Live Load (LL). 

 Create a combination of mass groups 
 

 
 

 Define a seismic spectrum. Let’s consider a seismic spectrum with the following parameters: 
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 Create the seismic load cases in X and Y direction in the Load cases menu: 

 

 
 

 
 

 Refine the mesh. For this example, we set the mesh as follow: 
 

 
 

 Chose the number of frequencies which have to be calculated (Setup > Solver). We chose 10 
values. 
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Step 2: Activate the option “Use IRS (Improved Reduced Model)” 

 

 

Step 3: Define storeys 

Define the Storeys form the Main menu > Line grid and storeys  
 

 
 
The levels are shown graphically. If you select a storey level, you can adapt its properties from the 
Properties window: 
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You can check if the supporting members of the building are properly allocated to storeys using the ‘Filtered 
Allocation of Entities’ property. 
 
Optionally, R-nodes may be placed at any level in each storey. The storey property “level of reduction point” 
allows selecting the exact height of the reduction point for each storey separately. 0 corresponds to the 
bottom of the storey, 1 to the top of the storey. 
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Step 4: Perform the linear calculation and check the results 

 

Summary Storey Results: 
 
 
There are 3 types of results: Storey data, displacements and accelerations. 
 

 Storey Data :  

Storey data displays for each storey the total mass and the coordinates of the mass center. It is only 
available with mass combinations 

 

 

 

 

 Displacements & accelerations: 

 

Displacements & Accelerations are available for eigenmodes and seismic load cases. The values of 
displacement & acceleration components are given at the mass center of each storey. 

Results for mass combinations are raw, normalized results from modal analysis, without effect of response 
spectrum. 
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Results for seismic load cases are values after modal superposition. 

 
 

 
 
Using the option ‘Additional values’ in the properties windows you can display more components: 
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Detailed Storey Results: 
 
 

Typical provided results are: internal forces, resultants per wall or per storey… 
 
Mainly 2 types of results are available in this service: 
 

 Internal forces in supporting members 
 

The result can be displayed on different section levels: 
 
- Top (section at the top of each storey)  
- Middle (section at mid-height of the each storey)  
- Bottom (section at the bottom of each storey)  
- User defined 
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 Resulting forces (by member) 
 
 
 

Location = by member: compute the resulting forces are 
computed for each wall member separately 

 
 
 

Resulting forces in 1D members (columns) are identical to 
internal forces in 1D members. 
 
Resulting forces in 2D members (walls) compute the resultant 
at the center of each wall, according to a dedicated local 
coordinate system, regardless of the System output setting. 
The coordinate system that is used is the same as the LCS of 
a vertical rib placed in the middle of the wall. It is also the 
same coordinate system that is used for integration strips. 
 
 
 
 
 
 

 The local X-axis is vertical, upwards 

 The local Z-axis is identical to the Z-LCS of the wall 

 Y = Z ^ X 
 
 
In this way, resulting forces in walls can be easily displayed together, 
consistently with internal forces in columns on a single drawing. 
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 Resulting forces (by Storey) 
 
 
Location = by storey: the resulting forces are computed for each 
storey, considering all the supporting members at once; 1D 
(columns) and 2D members (walls) are taken into account 
together 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Total vertical forces in all storeys 
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6.3 Accidental eccentricity (Accidental Torsion) 

 
The accidental eccentricity accounts for inaccuracies in the distribution of masses in the structure. Design 
codes usually take it into account as an additional eccentricity that is defined as a fraction of the size of the 
structure. 
 
In the Eurocode 8, the accidental eccentricity for a given floor is defined as 5% of the width of the floor 
perpendicularly to the direction of the acting seismic action. 
 
In SCIA Engineer, using the IRS condensed model allows introducing accidental eccentricity easily, since the 
condensed model uses only one R-node per storey. The accidental eccentricity may be taken into account 
either as real mass eccentricity or as additional torsion actions (simplified method according to the design 
codes). 
However, SCIA Engineer uses the simplified method using additional torsion moment. 
Accidental eccentricity is added through static loading (acc. EN 1998-1 4.3.3.3.3) 
 

 
 

Example 6-2: IRS_2_Accidental_torsion.esa 

In SCIA Engineer, the accidental torsion can be accounted for in a seismic project using the IRS method. 
Open the Load cases menu and select one type of Accidental eccentricity: 
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The following methods are available for calculation of AE moments: 

 Linear distribution of accelerations (EN 1998-1 4.3.3.3.3 and formula (4.11) ) 

 Distribution of accel. from eigenshape (EN 1998-1 4.3.3.3.3 and formula (4.10) ) 

 Accelerations from modal superposition 
 
Once the accidental eccentricity is selected, a new AE load case and also a new load group are 
automatically created: 
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7. Vortex Shedding: Karman Vibration 

 
In this final chapter, the transverse vibration of cylindrical structures due to wind is examined.  
First the theory is explained in which reference is made to the Harmonic load since Vortex shedding is 
a special case of harmonic loading. 
The theory is then illustrated by an example of a steel chimney for which the results are again verified 
by a manual calculation.  
 

7.1 Theory 

One of the most important mechanisms for wind-induced oscillations is the formation of vortices 
(concentrations of rotating fluid particles) in the wake flow behind certain types of structures such as 
chimneys, towers, suspended pipelines,… 
At a certain (critical) wind velocity, the flow lines do not follow the contours of the body, but break away 
at some points, thus the vortices are formed [27]. 
These vortices are shed alternately from opposite sides of the structure and give rise to a fluctuating 
load perpendicular to the wind direction. The following figure illustrates the vortex shedding for flow 
past a circular cylinder. The created pattern is often referred to as the Karman vortex trail [2]: 
 

 
 
When a vortex is formed on one side of the structure, the wind velocity increases on the other side. 
This results in a pressure difference on the opposite sides and the structure is subjected to a lateral 
force away from the side where the vortex is formed. As the vortices are shed at the critical wind 
velocity alternately first from one side then the other, a harmonically varying lateral load with the same 
frequency as the frequency of the vortex shedding is formed [23]. 

The frequency of the vortex shedding vf  is given by: 

d

vS
fv


           (6.1) 

With:  
   S = Non-dimensional constant referred to as the Strouhal Number 
        For a cylinder this is taken as 0,2. 
 d = Width of the body loaded by the wind [m] 
        For a cylinder this equals the outer-diameter. 
 v  = The mean velocity of the wind flow [m/s] 
 

The manner in which vortices are formed is a function of the Reynolds number Re, which is given by 
[24]: 

 
510687,0Re  dv          (6.2) 

 
In general large Reynolds numbers mean turbulent flow. The Reynolds number characterizes three 
major regions: 
 

Subcritical  
510Re300   

Supercritical  
65 105,3Re10   

Transcritical  Re105,3 6   

 
For chimneys with circular cross section the flow is either in the supercritical or transcritical range for 
wind velocities of practical interest. 
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If the vortex shedding frequency coincides with the natural frequency of the structure (resonance) quite 
large across-wind amplitudes of vibration will result unless sufficient damping is present. This principle 
was already discussed in Chapter 3. 
In this case, formula (6.1) can be rewritten to calculate the critical wind velocity at which resonance 
occurs: 

fdvcrit  5          (6.3) 

With: f   = Natural frequency of the structure 
 
The across-wind forces per unit length caused by the vortex shedding can be approximated by the 
following formula: [2] 

   tCvdtP tcritL  2

2

1
         (6.4) 

With:   = Air density taken as 1,25 kg/m³  

 tCt  = A lift coefficient that fluctuates in a harmonic or random manner  

  and depends of the Reynolds number. The following figure shows  
  this relation when Ct is proportional to the mode shape [24]. 

 
 
If the vortex shedding is taken as harmonic, equation (6.4) can be written as: 

   vtcritvL fCvdtPtP  2sin
2

1
)sin( 2

0        (6.5) 

According to reference [2], assuming a constant wind profile, the equivalent modal force due to the 
fluctuating lift force of equation (6.5) is given by: 

    
H

tvcritvL dzzzCfvdtPtP
0

2 )}(){(2sin
2

1
)sin(     (6.6) 

With:  

            )(z = Modal shape at height z 

 H = Total height of the structure 
 
As seen in Chapter 3, the dynamic amplitude Y at resonance can be written as: 

2
SY

Y            (6.7) 

 
The static deformation YS is given by: 

2

00

M

P

K

P
YS           (6.8) 

M is the equivalent modal mass of a prismatic member given by [2]: 
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dzzzmM

H

2

0

)}({)(          (6.9) 

With:  
m(z) = The mass per unit height 

 
When combining formulas (6.7) and (6.8) the maximum response of a SDOF system subjected to a 
harmonic excitation may be written as: 

 2

1
2


M

P
Y L          (6.10) 

It follows that when the vortex shedding occurs with the same frequency as the natural frequency of the 
structure, the maximal amplitude is given by: 
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      (6.11) 

When it is assumed that the mass per unit height is constant and that the lift coefficient is proportional 
to the mode shape, formula (6.11) can be simplified to the following: 










mS

Cd
Y t

22

3

16
        (6.12) 

This equation may be used as a first estimate of likely response of the structure. 
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7.2 Karman Vibration in SCIA Engineer 

In SCIA Engineer, the Vortex Shedding was implemented according the Czech loading standard [24]. 
The effect is only taken into account if the critical wind velocity calculated by formula (6.3) is between a 
minimal and maximal value. These two extremes can be defined by the user. According to [24] these 
values are taken as 5 m/s and 20 m/s. 
In addition to formula (6.11), in SCIA Engineer it is possible to specify the length of the structure where 
the Von Karman effect can occur. For each geometric node of the structure, it is possible to relate a 
length of the cylinder to the node. This implies that, in order to obtain precise results, the structure 
should be modeled with sufficient geometric nodes. 
By default the effect can occur over the entire height of the structure however, when there are specific 
obstacles on the surface of a chimney for example, these obstacles will hamper the formation of the 
vortices and thus reduce the Von Karman effect. In practice, this is exactly the solution to suppress 
vortex-induced vibration: the fitting of special ribs on the surface of the cylinder. 
 
The following diagram shows the required steps to perform a Vortex Shedding calculation: 
 

 
 
This diagram will be illustrated in the following example. 
 

  

 Activate the Dynamics functionality 

Input Masses Generate Masses from Static Load cases 

Create a Mass Group 

Create a Mass Combination 

Perform a Linear Calculation 

Refine the Finite-Element Mesh if required 

Specify the number of Eigenmodes to be calculated 

Create a Karman Vibration Load case 

Input Karman Loads (lengths) 
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Example 7-1: Vortex_Shedding.esa 

In this example, a steel chimney is modeled with a fixed base. 
The chimney has an outer-diameter of 1,2m and a thickness of 6mm. The total height is 30m and the 
structure is manufactured in S235 according to EC-EN. 
To take into account the weight of insulation, electrical cables and other non-structural elements, a 
distributed mass of 55 kg/m is inputted. 
No specific structural measures are taken to prevent the vortex shedding thus the entire length of the 
chimney must be taken into account for the Von Karman vibration. 
To this end, the chimney is modeled as a cantilever built up as 30 members to create sufficient 
geometric nodes. Each node (except the base and top) will be assigned a chimney length of 1m. 
For the logarithmic decrement of the chimney, a value of 0,025 is used. 
 
One static load case is created: the self-weight of the structure. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 1: Functionality 

The first step in the Karman Vibration calculation is to activate the 
functionality Dynamics on the Functionality tab in the Project Data. 
 

Step 2: Mass groups 

The second step is to create a Mass Group. 
 

 
 
Actually, this mass group doesn’t contain anything, since the self-weight is automatically taken into 
account. But to do dynamic calculation, at least one Mass Group needs to be defined. 
 
In this mass group, we are going to place some additional masses. This will be added to the mass 
coming from the self weight (which is always and automatically taken into account). 
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Step 3: Masses 

After the Mass Group has been created; the distributed mass of 55 kg/m can be inputted on all 
members. 
 

 

Step 4: Mass matrix 

Next, the Mass Group is put within a 
Combination of Mass Groups, which can 
be used for defining the harmonic load. 

 
 
 
 
 
 
 
 

Step 5: Karman vibration load case 

After creating a Mass Combination, a Karman vibration load case can be defined through Load cases, 
Combinations > Load Cases. 
 
The Action Type of the Load Case is set to Variable. 
 
The Load Type can then be changed to Dynamic. 
Within the Specification field, the type of dynamic load can be set, in this case Karman vibration. 
 

- The logarithmic decrement was given to be 0,025. 

- The Diameter of the tube was 1,2m. 

- The Wind direction is defined in the Global Coordinate System. A direction of 0,00 deg 
specifies the global X-axis. This implies that the Karman vibration will occur in a direction along 
the Y-axis (perpendicular to the wind direction). 

- As specified in paragraph 6.2 the minimal and maximal wind velocities are set to 5 m/s and 20 
m/s respectively. Vortex shedding will only occur if the critical wind velocity is between these two 
limits. 
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- The option ‘Select eigenshape’ can be used to manually specify for which eigenmode the 
Vortex shedding needs to be calculated. When this option is left to ‘Automatic’, SCIA Engineer 
determines the representative mode automatically (which is the one with the biggest modal 
participation factor in the relevant direction) 
 
Since the wind direction is set along the global X-axis, the representative mode will be a mode 
shape along the global Y-axis. 

 

 
 
 

Step 6: Karman load 

The parameters of the load case have been defined, what is left is to specify 
the length of the structure where the Von Karman effect can occur.  
 
As indicated in paragraph 6.2; SCIA Engineer allows relating a length of the 
chimney to each geometric node. 
 
This load can be inputted through Load > Point Force > Karman Load 
As no specific measures were taken to prevent vortex shedding and since the 
chimney was inputted as 30 members, each node is assigned a length of 1m.  
 
Additional nodes are made at 0,25m from the base and top. These nodes also 
get Karman loads assigned to them of 0,50m. 
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Step 7: Mesh setup 

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined. The Average 
number of tiles of 1D element is set to 5 through Calculation, Mesh > Mesh Setup. 
 

 
 

Step 8: Solver setup 

 
Step 8: The last step before launching the calculation is setting the amount of eigenmodes to be 
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this 
example. 
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Step 9: Linear calculation and results 

All steps have been executed so the Linear Calculation can be started through Calculation, Mesh > 
Calculation. 
 
The Calculation Protocol for the Eigen Frequency calculation shows the following: 
 

 
 
The details of the Karman Vibration calculation can be found in the Calculation Protocol for the 
Linear calculation: 

 
 
As expected, the Vortex shedding was analyzed for the second eigenmode, the mode with largest 
mass participation in the Y-direction. 
 
The Maximum and Reduced loads are intermediate results used to calculate the across-wind forces 
according to [24]. 
 
The maximum horizontal translation for the second eigenmode can be found through Deformation of 
Nodes (note that the value has no relevance, the direction however is very important): 

 
 
In the same way, the total deflection of the top of the chimney caused by the Karman Vibration can be 
shown: 
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It is clear that this large translation at the top will cause considerable stresses at the base of the 
chimney.  
As specified in Chapter 3, a combination of type Envelope can take into account both sides of the 
vibration amplitude since a vibration is always in both directions. 
An envelope combination is created for the chimney to evaluate the stresses at the base: 
 

 
 
The Member Stresses for the lower member of the chimney give the following normal stresses for the 
combination: 

 
 
A stress range of 207,3 MPa will lead to significant fatigue problems after even a low amount of cycles. 
This is one of the most reported types of failures due to Vortex shedding.  
A solution to this problem is the fitting of a helix type rib to prevent the correlation of the vortices (and 
thus lower the chimney-length which must be taken into account for the Von Karman effect). The 
disadvantage of such a rib is that it increases the drag force [2]. 
Since the Vortex shedding is a state of resonance, the amplitude is damping dependent as explained 
in Chapter 3. Another solution is thus to increase the damping by installing a tuned mass damper 
system [23].  
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Manual Calculation 

In order to check the results obtained with SCIA Engineer, a manual calculation is performed. 
First of all, the fundamental natural frequency of the chimney is approximated by the following formula 
given in Eurocode 1 [4]: 
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                  (6.13) 

With:  

    l = 1000 for steel chimneys 
 d = Diameter of the chimney at the top  [m] 
 heff = Total height of the chimney for a prismatic cantilever structure [m] 

                Ws = Weight of the structural elements which add to the stiffness of the  
                chimney, in this case only the self-weight of the chimney. 
  Wt = Total weight of the chimney, thus including the additional weight. 
 
 
The self-weight of the chimney is given in the Bill of Material: 

 
 







556,176

6,176

30

2,11000
2

f 1,16 Hz 

This result is a good approximation of the result of 1,18 Hz calculated by SCIA Engineer. 
 
Next the result of the Von Karman vibration is verified. 
The critical wind velocity at which resonance occurs is calculated using formula (6.3): 

1834,12,155  fdvcrit = 7,10 m/s 

 
The critical wind velocity is between the upper and lower limit of 5 m/s and 20 m/s thus vortex 
shedding is likely to occur. 
Using formula (6.2) the Reynolds number Re is calculated: 

 55 102,110,7687,010687,0Re dv 585356,98 

 
Using the Reynolds number, the lift coefficient Ct can be calculated: 

 
 

 
These intermediate results correspond to the results calculated by SCIA Engineer. 

585356,9
8 

0,568
6 
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As an approximation of the response at the top of the chimney, equation (6.12) can be used: 
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 With:   = 1,25 kg/m³ 
  S = 0,2 
  m = 176,6 kg/m + 55 kg/m 

   = 0,003979 for a logarithmic decrement of 0,025 
 





 mY 21099,0

003979,0)556,176(2,016

5686,02,125,1
22

3


210,99mm 

 
This result corresponds to the result calculated by SCIA Engineer. 
Eurocode 1 [4] gives an approximate formula to calculate the amount of cycles a chimney is subjected 
to due to vortex shedding. This can be used in a fatigue analysis. 
Adaptations to the formulas for formations of cylindrical elements like chimneys and cables are found in 
the same reference. 
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8. Direct Time Integration 

8.1 Theory 

The title may be misleading because normally in the literature, this name is used for a dynamic 
computation without modal superposition. In SCIA Engineer, the eigenmodes are determined first and 
are used to uncouple the equilibrium equations into a set of m uncoupled second order differential 
equations which are solved one by one by direct time integration. The uncoupling is based on the 
properties given by equations 
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In equation (3.1) a solution for y is assumed to be of the form: 
 

 y =  Q           (7.1) 
 

Where  is the matrix of eigenvectors (n*n) and Q is a vector which is time dependent. 
 
Substitution in equation (3.1) gives: 
 

 FQKQCQM          (7.2) 

 

When the equation is pre-multiplied with 
T
 and the above equations are taken into account, one obtains: 

 

 FQQCQ TT   ²        (7.3) 

 
This set of equations is still coupled because of the damping term. If however C-orthogonality is assumed 

(this means that  
T
.C.  reduces to only diagonal terms), then the equations are uncoupled and can be 

solved separately. The global results are obtained by superposition of the individual results (7.1) is also 
the exact solution if the assumption of C-orthogonality holds. If however, only a few eigenvectors (m<n) 

are used in  instead of all the eigenvectors, then the system of equations and the superposition of the 
solutions gives a solution y which is an approximation of the exact solution. 
 
In SCIA Engineer, C-orthogonality is assumed and it is also assumed that all modal damping factors are 
constant. This means that: 
 

     T

i ijC     2         (7.4) 

 

The value of  is one of the input data and is called damping factor. 
 
The number of eigenvectors that is taken into account is also specified by the user. This value is equal to 
the number of eigenvectors computed in the eigenvalue computation. 
The method used to solve each uncoupled second order differential equation is the Newmark-method. 
This method is unconditionally stable but the accuracy depends on the time step. This time step has to be 
given by the user. However, to help him in his choice, a value determined by the program will be used if 
the user does not specify a value. This proposed value is computed as: 0.01 T 
Where T smallest period of all the modes which have to be taken into account 
 
This proposed value guarantees accuracy better than 1% over each period of integration of this highest 
mode. In most cases, a larger time step can be used because the contribution of this last mode is small. 
This brings us to the question about the number of modes that should be used. When the time dependent 
terms on the left hand side of equation (7.3) are neglected, the solution for qj (a term of Q) is: 
 

 q Fj j j

T  1 2/           (7.5) 
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This indicates that the lowest eigenmodes (j small) will contribute more than the highest modes (j 
large), if dynamic terms are neglected. This can give a first idea on how many modes to use. 
A second criterion is the periodicity of F. Any mode which coincides with the loading frequency should be 
taken into account. 
Modal weight is a third criterion that can be used. If you add all modal weights in a particular direction 
together and divides this result by 9.81*sum of nodal masses in the same direction, you obtain a value 
smaller than 1. If this value is close to 1, it means that the higher modes will not contribute anymore. If, on 
the contrary, the value is smaller than 0.9, one can doubt about the value of a subsequent modal 
superposition. 
 

8.2 Direct Time Integration in SCIA Engineer 

In SCIA Engineer, it’s possible to input a dynamic function. This can be used for different purposes, for 
example: harmonic loads, explosions, … In this case, the user has to input a dynamic function which 
presents the frequency in function of the time. 
 
The following diagram shows the different steps which have to be performed for the time history 
calculation: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

  
Activate the  functionalities           -Dynamics   

   -General dynamics   

Input Masses   Generate Masses from Static Load cases   

Create a Mass Group   

Create a Mass Combination   

Perform a Linear Calculation   

Refine the Finite - Element Mesh if required   

Specify the number of Eigenmodes to be ca lculated   

    Create a ‘general dynamics’ load case     

Define  a  Dynamic load function    
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Example 8-1: Time_history_1.esa 

In this example an explosion is simulated on a concrete plate. 

 
The plate has a dimension of 6x6m and the thickness is 300 mm. The plate will be calculated 
according to the EC-EN and is made of concrete grade C30/37.  The four corners are supported by 
hinged supports.  
Three load cases are introduced:  

- Self weight  
- Permanent surface load: -4kN/m^2 
- Variable point load: Blast of -11 kN 

Step 1: Functionality 

Go to ‘Project>functionality’ and check the options:  
Dynamics and General dynamics 
 

Step 2: Mass groups and masses 

Open the menu ‘Dynamics’ and a mass group will be created here. For this, the permanent surface 
load of -4kN/m^2 is used. For this, you can click on the ‘create masses from load case’ button.  

 
 
A surface mass of 407.7 kg/m^2 is created. 
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Step 3: Mass matrix  

Next, a combination of mass groups can be created. 
 

 
 

Step 4: Dynamic load function 

 After the creation of masses, the explosion can be simulated by means of a dynamic load function.  
 
Go to ‘Libraries > loads > Dynamic load functions’.  
Here you can input the input of load coefficients in function in time.  
Two types of functions can be input, namely a base and/or modal function. If both are introduced, the 
user can choose if these functions have to be multiplied or summarized.  
4 types of functions can be chosen: constant, linear, parabolic or sinusoidal.  
 
In our example a modal function is created with linear lines: 
 

  
This function has to be attributed to a point load. We will do this in step 6. 
 

  



Direct Time Integration 

161 

Step 5: A ‘general dynamics’ load case 

A load case is introduced to simulate this explosion.  
The action type is Variable and the type of load Dynamic. 
 

 
 
For the load group, the user can choose a special case, namely Accidental. 
 

 
 
Next, the specification has to be selected and the type General dynamics has to be chosen for a time 
history calculation.  
For this, we need some extra parameters: 

 
Where: 

- Total time:  The total time of the dynamic analysis 
- Integration step: When ‘Auto’ is checked, then 1/100 of the smallest period is taken. 

When ‘Auto’ isn’t checked, then the user is allowed to select an integration step 
value. 

- Output step: Step for generating the load cases. The value need to be bigger or     equal at the 
integration step. 

- Log Decrement: Damping defined as logarithmic decrement   
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Step 6: Input of loads which follow the load function 

In this step, you will create of a nodal force. Only nodal forces can be linked to a dynamic function. 
The value of the nodal force, will be multiplied with the coefficients in the function to achieve the final 
force in function of time. 
 

 
 
A point force of -11kN is input in the middle of the plate. The user has the option to attribute the 
dynamic function DLF1 to this load.  
 

Step 7: Mesh setup 

Before the calculation, the mesh is refined to get precise results.  
 

 
 

Step 8: Linear calculation 

Now, the linear calculation can be performed.  
 
When the calculation is finished, new load cases are created which present the influence of the blast 
on the structure on each output step (the output time must always be smaller than ‘Total time’, so in 
this example, we used 1,51s as total time to get an output at 1,50s): 
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To find the most extreme result, these load cases can be input in a Result class.  
 

Step 9: Results 

The eigen frequencies are shown in the results menu: 

 
 
Other results, like for example deformations, can be regarded for the different output steps: 
 

- After 0.3 seconds: 
 
 
 
 
 
 
 
 
 
 
 
 

 
- After 0.6 seconds: 
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- After 0.9 seconds: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
- After 1.2 seconds: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
- After 1.5 seconds: 
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Or we can ask the result for the class which has been generated for the load cases. 
 

 
 

 
 

If you choose refresh, then you can see Uz for each 0,3 seconds in the selected node. 

 
  



Advanced Professional Training - Dynamics 

166 

If we would set the output step to 0,01s in the dynamics load case, then you would get 150 load cases. 
 

 
 
 
 And as a result, the “deformation in nodes” graph would give more detailed representation: 
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Example 8-2: Time_history_2_-_RunningLoad.esa 

In this example a running load over a bar is simulated. 

 
 
The beam has a length of 20m and a section HEA200. The beam will be calculated according to the 
EC-EN and is made of steel S235. The edges are supported by hinged supports.  
Two load cases are introduced:  

- Self weight  
- Variable dynamic load: Point loads of  -100 kN on every 2m over the beam 

 

Step 1: Functionality 

Go to ‘Project>functionality’ and check the options: Dynamics and General dynamics 
 

Step 2: Mass groups 

Open the menu ‘Dynamics’ and a mass group will be created here. For this, no mass is inputted. Only 
the self weight is taken into account. 
 

Step 3: Mass matrix 

Next, a combination of mass groups can be created. 
 

 
 

Step 4: Dynamic load functions 

After the creation of masses, the running load can be simulated by means of dynamic load functions.  
 
Go to ‘Libraries > loads > Dynamic load functions’.  
Here, the input of frequencies in function in time is asked.  
 
Two types of functions can be input, namely a base and/or modal function. If both are introduced, the 
user can choose if these functions have to be multiplied or summarized.  
4 types of functions can be chosen: constant, linear, parabolic or sinusoidal.  
 
In this example 9 modal functions are created with linear lines: 

- DLF1 is 1,00 from 0,2s to 0,4s 

- DLF2 is 1,00 from 0,4s to 0,6s 

- … 
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Each function will be attributed to a different point load (see step 6).  
DLF1 to the first point load from the left. DLF2 to the second point load from the left. And so on... 
 
These 9 load functions will be used to simulate the effect of a point load moving from left to right over a 
time period is simulated. On each point (every 2m) the point load stays for a time of 0.20sec. So it 
takes 2 seconds for the point load to cross the whole beam. 
 

Step 5: General dynamics load case 

A load case is introduced to simulate this running load.  
 
The action type is Variable and the type of load Dynamic 
 
For the load group, the user can choose a special case, namely Accidental. 
 

 
 
Next, the specification has to be selected and the type General dynamics has to be chosen for a time 
history calculation. After chosing general dynamics, some extra parameters have to be defined. 
 

- Total time [s]: The total time of the dynamic analysis. 
 

- Integration step: When ‘Auto’ is checked, then 1/100 of the smallest period is taken. 
When ‘Auto’ isn’t checked, then the user is allowed to select an integration step value. 

- Output step [s]: The step is used to determine on which points in time results must be 
generated. These will be saved in new generated load cases. 

- Log Decrement: Damping defined as logarithmic decrement  
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Step 6: Input of loads 

In this step, nodal forces will be inputted. Dynamic load functions can only be linked to nodal forces. 
Since they are ‘nodal’ forces, the user must proved internal nodes to place these internal forces on. 
Every 2m an internal node has to be created on the beam. On each of these nodes a point force of    -
100 kN is set. The first point force from the left is linked to DLF1, the second to DLF2,...  
This models the movement a single point load over the beam left to right over the beam in a total time 
of 2 sec. 
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Step 7: Linear calculation 

Now, the calculation can be performed.  
When the calculation is finished, new load cases are created which present each output step: 
 

 
 
To find the most extreme result, these load cases are automatically input in a result class: 
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Step 9: Results 

 
The eigen frequencies are shown in the results menu: 

 
 
Other results, like for example deformations, can be regarded for the different output steps: 
 

- After 0.5 seconds: 

 
- After 1 seconds: 

 
- After 1.5 seconds: 

 
- After 2 seconds: 

 
- After 2.4 seconds: 

 
 

- The result class shows the envelope of all possible results over time: 
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It is also possible to see the result in a certain point for all load cases in one picture. By this it is 
possible to see the result over the time. 
 
Consider for instance the vertical displacement of the middle node N6. 
 

 
 
The deformation of the middle node in function of the time is shown in the result preview. 

 
 
This result clearly represents the vibration of the middle point over time.



References 

173 

References 

[1]  Beards F., Structural Vibration: Analysis and Damping, Arnold, London, 1996. 
[2] H. Buchholdt, Structural Dynamics for Engineers, Thomas Telford Publications, 1997. 
[3] Chopra A., Dynamics of Structures: Theory and Applications to Earthquake Engineering, 

Prentice Hall, New Jersey, 2001. 
[4] Eurocode 1: Basis of design and actions on structures, Part 2-4: Actions on structures - 

Wind actions, ENV 1991-2-4, 1995. 
[5] Eurocode 3: Design of Steel Structures, Part 1-9: Fatigue Strength of Steel Structures, ENV 

1993-1-9: 2002. 
[6] Eurocode 8: Design of structures for earthquake resistance, Part 1-1: General rules, seismic 

actions and rules for buildings, ENV 1998-1-1, 1994. 
[7] Eurocode 8: Design of structures for earthquake resistance, Part 1: General rules, seismic 

actions and rules for buildings, EN 1998-1, 2004. 
[8] Eurocode 8: Design provisions for earthquake resistance of structures, Part 6: Towers, 

masts and chimneys, Annex B, ENV 1998-6, 2003. 
[9] Eurocode 8: National Application Document for Belgium, NBN-ENV 1998-1-1, 2002 NAD. 
[10] Murray M., Allen D., Ungar E., Floor Vibrations due to Human Activity, AISC, 2003. 
[11] Leijendeckers P.P.H., Fortuin J.B., Van Herwijnen F., Leegwater H., Polytechnisch 

zakboekje (Polytechnic pocket notebook), 48
e
 druk, Koninklijke PBNA, 1998 (in Dutch). 

[12] Ghali A., Neville A.M., Structural Analysis: A unified classical and matrix approach, 
Chapman and Hall, London, 1990. 

[13] EPFL-ENAC-SGC, Génie Parasismique, Quotient de Rayleigh (Rayleigh Quotient), Suisse, 
2004 (in French). 

[14] Xiang Y., Wei G.W., Exact Solutions for Vibration of Multi-span Rectangular Mindlin Plates, 
Journal of Vibration and Acoustics Vol.125, ASME, 2002. 

[15] Whalen T.M., Course CE573: Structural Dynamics, Problem 3.10, Purdue University, 
Indiana, 2004. 

[16] SCIA Group NV, ESA-Prima Win: Dynamics – Theoretical Background, Herk-de-Stad, 2002. 
[17] U.S. Army Corps of Engineers, Engineering and Design - Seimic Design Provisions for 

Roller Compacted Concrete Dams, EP 1110-2-12, 1995. 
[18] Wilson E., Three-Dimensional Static and Dynamic Analysis of Structures, CSI, Berkley, 

2002. 

[19] ASCE4-98, Seismic Analysis of Safety-Related Nuclear Structures and Commentary, 2000. 

[20] Chowdhury I., Dasgupta S., Computation of Rayleigh Damping Coefficients for Large 
Systems, EJGE, 2003. 

[21] NF P 06-013, PS92: Les Règles de la construction Parasismique (Rules for Seismic 
Structures), 1995 (in French). 

[22] Vandepitte D., Berekening van Constructies (Calculation of Structures), Story-Scientia, 
Gent, 1979 (in Dutch). www.berekeningvanconstructies.be 

[23] Transvik P., Alpsten G., Dynamic Behaviour under Wind Loading of a 90m Steel Chimney, 
Report S-01041, 2002. 

[24] Czech Standard CSN 73 0035: Actions on Structures, 1986 (in Czech). 
[25] Vandewalle J., Cools R., Lineaire Algebra en Analytische Meetkunde (Linear Algebra and 

Analytical Geometry), Garant, Leuven, 1998 (in Dutch). 
[26] Toratti T., Seismic Design of Timber Structures, Tekes, 2001. 
 
[27] Billah Y., Scanlan R., Resonance, Tacoma Narrows bridge failure, and undergraduate 

physics textbooks, Am. J. Phys. 59 (2), American Association of Physics Teachers, 1991. 
[28] Lee I., AE514: Finite Element Methods in Structural Dynamics, Aero elasticity and Structural 

Dynamics Lab., Dept. of Aerospace Engineering, Kaist, 2001. 
[29] Vladimír T., Reinhard M., Local magnitude, surface wave magnitude and seismic energy, 

Studia Geophysica et Geodaetica, 1991. 
[30] Nederlands Normalisatie-instituut, Beoordeling van de constructieve veiligheid van een 

gebouw bij nieuwbouw, verbouw en afkeuren – Grondslagen voor aardbevinstbelastingen: 
geïnduceerde grondslagen. 

http://www.berekeningvanconstructies.be/


Advanced Professional Training - Dynamics 

174 

Annex A: Earthquake Magnitude 

To assess the magnitude of earthquakes, a scale to describe the energy released during an 
earthquake was developed by Richter in the 1930s. This is named the Richter scale and it is the most 
common scale used today to describe earthquakes [26]. 
The magnitude of an earthquake on the Richter scale is determined by a so-called Wood-Anderson 

seismograph maximum amplitude, where M = log(a), and a is the maximum amplitude [m] at a 100 
km distance from the epicenter.  
The seismic action on buildings cannot be described by the Richter scale magnitude and this may not 
be used in the design. However, Housner in 1970 developed empirical relationships between the 
magnitude, the duration and the peak ground acceleration to be used in design: 
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Annex B: Numerical Damping Values  

In this annex, some numerical values for structural damping are given. 
A.  EC 8 - Part 6 (ENV 1998-6:2003 Annex B) suggest the following values for the damping ratio: 

Structural material Damping ratio   

Steel elements 1%  -  4% 

Concrete elements 2%  -  7% 

Ceramic cladding 1.5%  -  5% 

Brickwork lining 3%  -  10% 

 

B.  Other values for damping are suggested by EC1 - Part 2-4 (ENV 1991-2-4:1995 Annex C): 

The fundamental logarithmic decrement d  is given by: 

das dddd    

Where: 

 sd   :  Fundamental structural damping,  

 ad   :  Fundamental aero dynamical damping 

 dd   :  Fundamental damping due to special devices 

 
The structural damping is given by: 

min

111





s

s

d

bnad
  

Where: 

 1n   :  Fundamental flexural frequency,  

min11 ,, ba  :  Parameters given in the following table for different structural types. 

 

Structural type 
1a  1b  min  

Reinforced concrete buildings 0.045 0.030 0.080 

Steel buildings 0.045 0 0.050 

Mixed structures: concrete + steel 0.080 0 0.080 

Reinforced concrete towers 0.050 0 0.025 

Lattice steel towers 0 0.030 0 

Reinforced concrete chimneys 0.075 0 0.030 

Prestressed steel cable 0 0.010 0 

Unlined welded steel stacks 0 0.015 0 

Steel stack with one liner or thermal insulation 0 0.025 0 

Steel stack with two or more liners 0 0.030 0 

Steel with brick liner 0 0.070 0 

Coupled stacks without liner 0 0.015 0 

Guyed steel stack without liner 0 0.040 0 

Steel bridges Welded 0 0.020 0 

High resistance bolts 0 0.030 0 

Ordinary bolts 0 0.050 0 

Concrete 
bridges 

Prestressed without 
cracks 

0 0.040 0 

With cracks 0 0.100 0 

Bridge cables Parallel cables 0 0.006 0 

Spiral cables 0 0.020 0 

 
E.g.:  for a steel building with first frequency of 3Hz, the logarithmic decrement is:  

0.045 x 3  + 0   = 0.135   (> 0.05) 
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C. Other values for the logarithmic decrement are suggested by [22]: 

 

Structural material Logarithmic decrement 

Steel (welded) 0,025 

Reinforced or Prestressed Concrete  0,056 

Brickwork 0,25 

Wood 0,13 

In this reference, preliminary formulas can also be found for aerodynamic damping and damping 
caused by the foundation. 
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Annex C: Manual calculations spectral analysis 

Example 4-2x: Spectral_Analysis_manual_calculation.esa 

In this paragraph, the seismic results of SCIA Engineer are calculated manually to give a clear 
understanding of the applied formulas. All formulas can be found in the paragraph “Calculation 
Protocol” of this chapter. 
 
The reference project is not completely the same as the one described in example 4-2. The differences 
will be shown first before starting the manual calculation. 
 

Seismic load case 

The properties which have been used in the seismic load case can be seen here: 
A different acceleration factor has been used. This reduces the accelerations given by the spectrum. 
 

 
 

Spectrum 

A manual seismic spectrum is used. 
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Finite element mesh and solver setup 

The finite element mesh has not been refined. 
 

 
 
The solver also has not been changed to neglect shear deformations. 
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Manual calculation of example 4-2x 

Verification of modal participation factors 

First, the Modal Participation Factors of the Eigen Frequency Calculation Protocol are verified. 
 
As shown in the Deformation of Nodes, the normalized modal shapes for both modes were the 
following: 

   
 

 1

0,039111

0,020803

0,006128

0



 
 
 

  
 
  

    2

0,020233

0,030451

0,025755

0



 
 
 

  
 
  

 

 

Participation factor: }{}{)(, mT

kjk    

021,33500006128,0500020803,0500039111,0)1(,  x  

984,17500025755,0500030451,0500020233,0)2(,  x  

 

Effective mass: 
2

)(,)(,, jkjefkM   

  39,1090021,33
2

)1(,,  efxM  

  42,323984,17
2

)2(,,  efxM  

 

Participation mass ratio: 

totk

jefk

jk
M

M
L

,

)(,,

)(,   





500500500

39,1090
)1(,xL 0,7269 





500500500

42,323
)2(,xL 0,2156 

 
These results correspond to the results obtained by SCIA Engineer. They can be found in SCIA 
Engineer in the Calculation protocol (Eigen frequency). 
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Details of the seismic calculation 

Next, the details of the seismic calculation found in the Calculation Protocol for the Linear 
Calculation are verified. 
 

 
 
The spectral acceleration Sax for both modes is calculated using the defined seismic spectrum. 

The spectrum for Ground Type B with a Behavior Factor q = 2 gives the following values for Sd(T)/ 

 
 

The first mode has a period T1 of 1,9036 s  Sd(T1)/ = 0,5918 m/s² 

The second mode has a period T2 of 0,2920 s  Sd(T2)/ = 1,25 m/s² 

In this example, the coefficient of acceleration  was 0,35 

22)1(, 2071,035,05918,0
s

m
s

mSax 
 

22)2(, 4375,035,025,1
s

m
s

mSax   

 
These results correspond to the results obtained by SCIA Engineer. The small deviation is due to the 
fact that SCIA Engineer uses more decimals. In the further analysis, the spectral accelerations of SCIA 
Engineer are used. 
 

Mode coefficient: 
2

)(

)(,)(,,

)(,

j

jkjka

jk

S
G




  

 
6119,0

3007,3

021,332019,0
2)1(, 


 xG

 

 
0170,0

5192,21

984,174380,0
2)2(, 


 xG

 
 
These results correspond to the results obtained by SCIA Engineer. 
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The necessary intermediate results are calculated so the response of each mode can now be obtained. 
First, for each mode, the lateral force in each node can be calculated. These lateral forces can then be 
used to calculate the base shear and overturning moment. 
 
Mode 1:  

Lateral force in node i: )(,,)(,)(,,)(,,)(,, jkijkjkajkijki SmF    

N
s

mkgF x 38,130039111,0021,332019,0500 2)1(,,4   

N
s

mkgF x 35,69020803,0021,332019,0500 2)1(,,3   

N
s

mkgF x 43,20006128,0021,332019,0500 2)1(,,2   

NF x 0)1(,,1   

 

Base Shear Force: 
i

jkijk FF )(,,)(,  

 NNNNF x 129,22043,2035,6938,130)1(,  0,2201 kN 

 

Overturning moment in node i: ijkijki zFM  )(,,)(,,  

NmmNM y 50,15641238,130)1(,,4   

NmmNM y 77,554835,69)1(,,3   

NmmNM y 71,81443,20)1(,,2   

NmM y 0)1(,,1   

Overturning Moment: 
i

jkijk MM )(,,)(,  

 NmNmNmNmM y 89,220071,8177,55450,1564)1(,  -2,2009 kNm 

 

Note: 

In this mode, all lateral forces in the nodes are oriented the same way. The lateral loads in the nodes are in 

this case oriented in the negative X-direction so the Base Shear Force is oriented in the positive X-direction. 

The lateral loads in the nodes thus produce a negative Overturning Moment around the Y-axis. An example of 

this principle can be found in reference [26]. 

 

However, as stated in the previous chapters, the signs have no absolute importance since vibration amplitudes 

always occur on both sides of the equilibrium position. 

 
 
Mode 2:  

Lateral force in node i: )(,,)(,)(,,)(,,)(,, jkijkjkajkijki SmF    

N
s

mkgF x 69,79020233,0984,174380,0500 2)2(,,4   

N
s

mkgF x 93,119030451,0984,174380,0500 2)2(,,3   

N
s

mkgF x 44,101025755,0984,174380,0500 2)2(,,2   

NF x 0)2(,,1   

 

Base Shear Force: 
i

jkijk FF )(,,)(,  

 NNNNF x 68,14144,10193,11969,79)2(,  0,1417 kN 
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Overturning moment in node i: ijkijki zFM  )(,,)(,,  

NmmNM y 25,9561269,79)2(,,4   

NmmNM y 45,959893,119)2(,,3   

NmmNM y 74,405444,101)2(,,2   

NmM y 0)2(,,1   

 

Overturning Moment: 
i

jkijk MM )(,,)(,  

 NmNmNmNmM y 94,40874,40545,95925,956)2(,  -0,4089 kNm 

 
To obtain the global response, the modal responses need to be combined. In this example the SRSS-
method was used: 

        
222

)2(,

2

)1(, 1417,02201,0 kNkNFFF xxx 0,2618 kN 

        
222

)2(,

2

)1(, 4089,02009,2 kNkNMMM yyy 2,238 kNm 

 
These results correspond exactly to the results obtained by SCIA Engineer. We will show them again: 

 
 
As specified in the theory, these same principles can now be used to calculate the displacements and 
accelerations for each mode. These modal responses can then be combined again to obtain the global 
displacements and accelerations of the structure. 
 
Mode 1: 

Displacement in node i: )(,,)(,)(,, jkijkjki Gu   

  mu x 02393,0039111,06119,0)1(,,4 23,93 mm 

  mu x 01273,0020803,06119,0)1(,,3 12,73 mm 

 mu x 00375,0006128,06119,0)1(,,2 3,75 mm 

)1(,,1 xu 0 mm 

 

Acceleration in node i: )(,,)(,

2

)()(,, jkijkjjki Gu    

   2

2

)1(,,4 26073,0039111,06119,03007,3
s

ma x 260,73 mm/s² 

   2

2

)1(,,3 13868,0020803,06119,03007,3
s

ma x 138,68 mm/s² 

   2

2

)1(,,2 04085,0006128,06119,03007,3
s

ma x 40,85 mm/s² 

)1(,,1 xa 0 mm/s² 

 
Mode 2: 

Displacement in node i: )(,,)(,)(,, jkijkjki Gu   

  mu x 00034,0)020233,0(0170,0)2(,,4 -0,34 mm 

  mu x 00052,0030451,00170,0)2(,,3 0,52 mm 

 mu x 00044,0025755,00170,0)2(,,2 0,44 mm 
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)2(,,1 xu 0 mm 

 

Acceleration in node i: 
)(,,)(,

2

)()(,, jkijkjjki Gu    

   2

2

)2(,,4 15928,0)020233,0(0170,05192,21
s

ma x -159,28 mm/s² 

   2

2

)2(,,3 23972,0030451,00170,05192,21
s

ma x 239,72 mm/s² 

   2

2

)2(,,2 20275,0025755,00170,05192,21
s

ma x 202,75 mm/s² 

)2(,,1 xa 0 mm/s² 

 
To obtain the global response, the modal responses need to be combined. In this example the SRSS-
method was used: 
 
Displacements: 

        
222

)2(,,4

2

)1(,,4,4 34,093,23xxx uuu 23,93 mm 

        
222

)2(,,3

2

)1(,,3,3 52,073,12xxx uuu 12,74 mm 

        
222

)2(,,2

2

)1(,,2,2 44,075,3xxx uuu 3,78 mm 

xu ,1 0 mm 

 
Accelerations: 

        
222

)2(,,4

2

)1(,,4,4 28,15973,260xxx aaa 305,53 mm/s² 

        
222

)2(,,3

2

)1(,,3,3 72,23968,138xxx aaa 276,94 mm/s² 

        
222

)2(,,2

2

)1(,,2,2 75,20285,40xxx aaa 206,82 mm/s² 

xa ,1 0 mm/s² 

 
In SCIA Engineer, a specific result menu Seismic Detailed was designed to view these modal 
displacements and accelerations. 
In the Properties Window, the options for viewing the modal results can be set: 
 

  

 In the field Load Cases, a Seismic Load case can be selected. 

 The field Modal results allow choosing between the Displacements or Accelerations. 

 Evaluation for is used to specify which results need to be shown: the results for a specific 
Eigenmode, the results for All Eigenmodes or the global, Summarized results. 

 
The results for each mode and the summarized results are shown on the next pages for both the 
displacement and the accelerations. 
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Displacements 

Mode 1 

 
 
 
 
Mode 2 

 
 
 
 
Summarized 
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Accelerations 

Mode 1 

 
 
 
 
Mode 2 

 
 
 
 
Summarized 

 
 
When comparing the results of the manual calculation and those obtained by SCIA Engineer, it is clear 
that both calculations correspond. 
 

 
 
As specified in the theory, when using the CQC-method, a damping spectrum needs to be defined. To 
illustrate this, the above example is calculated again, but now using the CQC-method for the modal 
combination. 
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Annex D: Missing mass in modes 

As mentioned before, the sum of the effective modal masses for the modes taken into account must 
amount to at least 90%. The user can try to achieve this with the following possibilities: 

- Take more natural frequencies into account. 

- Assign mass more to nodes/connection instead of beams (to avoid local eigenmodes). 
 
The mass which has not been taken into account (for example, if the effective modal mass is 90%, 
then there is 10% not taken into account), can be treated in 3 possible different ways in SCIA Engineer: 
 

 
 
The used method is set in each seismic load case and is again displayed in the linear calculation 
protocol. Let’s take as example that the effective modal mass in a direction is 90%. Then how can the 
other 10% be treated? 

- Participation mass only: In this case, the 10% would be ignored. We would only take into 
account 90% of the mass of the structure to calculate the effects of an earthquake. 

- Missing mass in modes: In this case, the missing mass would be divided over the calculated 
modes. Which means the 10% would be distributed over the eigenmodes which make up for the 
90% which we did find. This is done according to their weight. So for the calculation of internal 
forces and deformations, the masses in the calculated modes would be increased by 100%/90% 
= 1,111… 

- Residual mode: In this case, a ‘fictual’ mode corresponding to the combination of all missing 
modes can be calculated. But since these missing modes are over different natural frequencies, 
the last found frequency will also be the natural frequency of this mode. In the calculation, the 
forces in this mode will be calculated in the same way as in the other modes. 

 
In the following examples the differences are explained in detail.  
In these projects the following general principle is used: 
First of all, a seismic spectrum is introduced. For this spectrum the modal displacements are calculated 
for each mode, in this case there are 2 modes. Afterwards, the displacements are transformed in real 
load cases. For these 2 load cases the results of the internal forces and reactions can be asked. 
According to the specific analysis method, the results are summed. On that way, one can compare 
these results with the output of the internal forces of the seismic load case. This will be done with the 
following three types of ‘mass in analysis’. 
 
Remark: The used method is displayed in the linear calculation protocol.  
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Example D-1: Participating_mass_only.esa 

If the option ‘Participation mass only’ is checked, the standard calculation is used. In this case, only the 
participation mass from the selected number of modes is taken into account and the user has to 
consider the 90% rule of the Eurocode. In other words, using this method it’s important that the total 
amount of the masses in X, Y and Z are sufficient. 
In the example, a structure made of beams with rectangular cross-sections is subjected to dynamic 
forces. The members are manufactured in C25/30 according to EC-EN. The height of each column is 
5m. 
Next, a seismic load case is introduced. The seismic spectrum acts in 3 directions. An acceleration of 2 
m/s^2 is given in function of the frequency.  
The evaluation method SRSS is used together with the option ‘Participation mass only’.  
The Eigen frequency analysis gives the following output: 

 
 
Deformation for mass combination CM1/1-2,05 : 

 

 
 
Deformation for mass combination CM1/2-2,39: 
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The masses of the participating nodes (N2, N4, N5 and N7) are needed. The mass is attributed to the 
end nodes of each member.  

 
 
Calculation of mass X for N2: 

Mass X (N2) = 2500 kg/m^3 x(2,5 x area (rect 150;150) + 3 x area (rect 300;150) + 1,5 x area (rect 
300;150) = 646,875 kg. 

 
The total mass matrix is: 

 
 
The modal participation factor is calculated as: 

 
 

Calculation of _x for mode 1: 

 ,(1)

0

0,001267

0

0,000778

0,001265

0

0,000777

x

 
 

 
 
 

  
 
 
 
 
 

and  

0

646,875

0

646,875

787,5

0

1537,5

xm
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,(1) 0,001267 647 0,000778 647 0,001265 788 0,000777 1538 3,514x           
 

The participation factor matrix is: 

 
 
Out of this matrix the effective masses can be calculated: 

 
 
Calculation of Mef for mode 1 in direction x: 

2

, ,(1) 3,514 12,346ef xM     

 
 
The formula for the participation mass ratio is as follows: 

 

,(1)

12,346
0,0034

3618,75
xL    

 
 
The acceleration response spectrum S has the constant value of 2 m/s^2: 

 
 
Calculation of mode coefficient in each direction: 

 
 

For example for direction x and mode 1: 

,(1)

2 3,514
0,042

166,4
xG


     

 
 

Now, the lateral forces can be calculated in each node: 

 
As example, this is calculated for node 2 in direction X: 

       2

, ,( ) , ,( ) , ,( ) , ,( ) ( ) , ,( ) ( )i k j i k j i k j i k j j i k j j
F m u m G
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2, ,(1) 646,875 0,7524 ( 0.001267) 166,4 102,6N xF N         

 
 
And also the shear forces in direction X, Y and Z: 
For mode 1 in direction x: 

,(1)

439,9
0,4399

1000
xF kN


     

 
 
The overturning moment in each node for each direction is:  

 

2, ,(1) 2, ,(1) (height - overturning height)

                   = 1227,3 (5 0 ) 6136,4

N x N yM F

N m m Nm

  

   
 

 
The other values are: 

 
 
The sum of the moments for each node gives the overturning moment in base: 

,( ) , ,( )k j i k j

i

F F l
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The moments for each separate mode are combined with the SRSS-method.  
 
Calculation of the modal displacement: 

 
 
For instance for node 2 in direction X and first mode: 

   (1) 0,7524G   and    2, ,(1) 0,001267N x    

2, ,(1) (0,7524 0.001267) 1000 0,95N xu mm       

 
Other values are:  

 
 
Calculation of the modal acceleration: 

 
 
For instance for node 2 in direction X and first mode: 

2

2, ,(1) 0,95 166,4 158,6mm/sN xü       
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Next, the displacements are inputted on the structure by means of a load case, namely translation of 
support: 

 
 
For these load cases the following internal forces are computed: 
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According to the SRSS-method the following formula is used: 





N

j

jtot RR
1

2

)(  

 
Take for instance the normal force in member B1: 

   
2 2

4,38 0,27 4.39totN kN kN kN     

 
 
These values correspond with the internal forces for the seismic load case in the project.  
 
The same can be done for the reactions: 

 

 
 
Calculation of the reaction for N1: 



Advanced Professional Training - Dynamics 

194 

2 2( 0,36 ) ( 0,36 ) 0,51xR kN kN       

 
 
After verifying the results in ‘Spectral_analysis_participation mass only.esa’ for the seismic load case, 
we can conclude that these values of the manual calculation correspond to the calculated values. 
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Example D-2: Missing_mass_modes.esa 

Consider the case that the following sum of masses is reached in direction X, Y and Z: respectively 
30%, 80% and 10%. 
With the option ‘missing mass in modes’, masses are added until a value of 100% is reached in each 
direction. With other words, the missing mass is assigned to the known modes ( modes selected by the 
user in the analysis) and then the modal deformations and forces can be computed. Afterwards it’s 
summed depending of the selected rule SRSS, CQC or MAX. 

 
 
Simply, in this case 70%, 20% and 90% masses are added. 
This principle is explained on the previous example. 
Instead of the option ‘participation mass only’ the option ‘missing mass in modes’ is checked.  
 
As a result of the previous example, the values of the effective masses are: 

 
 
The masses in the free nodes are: 

 
After comparing the real masses and the effective masses in each direction, one can conclude that 
there are ‘missing’ masses in the vibration analysis. 
Take for instance the masses in direction X: 

,1

,2

=3618,75 416,95 3201,80

3201,80
7,679

416,95

7,679 12,346 94,8

7,679 404,603 3107

miss

miss
miss

eff

miss

miss

M kg kg kg

M kg
R

M kg

M kg kg

M kg kg
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Calculation of the participation factor for the missing mass: 

  , , , , , , , ,(miss k j k j miss k j eff k j k jsign M M     
 

 
For instance for mode 1 in direction X: 

, ,(1) ( 94,8 12,346 3,514 ) 6,8miss x kg kg         

 
 
To take the missing mass into account in the calculation, this participation factor is included in the 
formula for the mode coefficient G: 

 
 
With Sa_cutoff: acceleration of ‘cut off’ frequency in direction k (i.e. last calculated frequency). 
For mode 1 in direction X: 

,(1)

2 3,514 2 6,8
0,124

166,4
xG

  
   

 
 
From now on, the same procedure can be followed as in the normal method. The formula for the 
lateral force in each node is: 

 
 

 
2, ,(1)

646,875 1,23 ( 12,67) 166,4
167,7

10000
N xF N

   
     

 
 
Next, the shear force in base is calculated: 
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Calculation of the overturning moment. The overturning height is 0: 

 
 

 
 
The sum of these moments gives the overturning moment in base: 

 
 
Also the modal displacements can be calculated for each node: 
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The modal accelerations are: 

 

 
 
Analogous to the previous example, these displacements for each mode are transformed to 2 real load 
cases. For these load cases the internal forces are analyzed: 
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Calculation of the normal force for member B1 according to the principle of SRSS: 

   
2 2

7,15 1,04 7,23N kN kN kN      

 
The other internal forces are calculated in the same way: 

 
 
This corresponds to the results for the seismic load case in SCIA Engineer: 
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This corresponds to the reactions in SCIA Engineer (Calculation of Rz for LC2): 
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Example D-3: Residual_mode.esa 

The principle of the residual mode method is analogous to the method of the missing mass:  
if there is too less mass taken into account with the standard method, more mass will be added to 
satisfy the prescriptions of the EC. 
The aim of this method is to evaluate the missing mass as an extra mode which is computed as an 
equivalent static load case. The static load case represents the weight of the missing mass under the 
cut-off acceleration. Afterwards it’s summed depending the selected rule SRSS, CQC, MAX. 
 
This is possible with the following option: 

 
 
The difference with regard to the previous method is that the missing mass is taken in the seismic 
analysis as an extra mode which represents the weight of the missing mass. The modal result of this 
mode is computed by a static equivalent load case.  
 
The effective masses are calculated for each separate node. In the other method, the effective mass 
was determined for each direction in each mode. Now, this parameter will be calculated for each 
different node in direction X,Y and Z for each mode. Later, this missing mass will be taken into account 
by means of an extra load case.  
 
Effective mass in node: 

 , ,( ), , ,

, ,( ),

,1000

k i k j i eff k j

eff k j i

k j

M M
M





 



 

 
Calculation of the effective mass in direction X for mode 1 and N2: 

 
, 2, ,(1)

646,875 ( 12,67) 12,346
2,9

10000 3,514
eff N x

kg
M
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The missing mass is the difference between the total mass for each node minus the effective mass: 

N2,xMissing mass 646,9 176,8 470kg     

 
mass x  mass y mass z  

 
[kg] [kg] [kg] 

N2 470,0 49,8 646,6 

N4 639,5 49,8 647,0 

N5 572,3 126,4 652,9 

N7 1520,0 246,8 1537,5 

 
Out of these missing masses, load cases are generated. This by the formula: 

, , ,( )Load case Missing massi k i k k cutoffS    

F x F y F z

[kN] [kg] [kg]

N2 0,940 0,100 1,293

N4 1,279 0,100 1,294

N5 1,145 0,253 1,306

N7 3,040 0,494 3,075

summ 6,4036 0,9457 6,9681

2

)j(

)j(,k)j(,k

)j(,k

Sa
G






 
 
Remark:  
The cut-off acceleration is the acceleration of the cut-off frequency, this is the last calculated frequency. 
 
 
Calculation of the mode coefficient: 

 
 

1/2
2

1/2

,(1)

2

2 3,514
0,042

166,4
x

m kg
sG m kg

s


      

 

(j) G_x G_y G_z G

[m*kg^0.5] [m*kg^0.5] [m*kg^0.5] [m*kg^0.5]

1 -0,042 0,673 0,122 0,752

2 0,178 -0,034 0,050 0,194  
 
Calculation of the lateral forces: 

1/2
2

1, ,(1)

646,9 0,75 12,67 166
102,6

10000
x

kg m kg mm
sF N

   
     

 

2

)j(

)j(,k)j(,k

)j(,k

Sa
G






       2

, ,( ) , ,( ) , ,( ) , ,( ) ( ) , ,( ) ( )i k j i k j i k j i k j j i k j jF m u m G
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, ( ) , ,( ) *i ki j i k j iM F z

mode 1

node F_x(1) F_y(1) F_z(1)

[N] [N] [N]

2 -102,6 1227,3 3,4

4 -63,0 1227,3 -2,9

5 -124,7 1541,8 1271,1

7 -149,6 3010,0 0,2

summ -439,9 7006,3 1271,8

mode 2

node F_x(1) F_y(1) F_z(1)

[N] [N] [N]

2 379,1 -558,3 -0,3

4 12,2 -558,3 0,6

5 461,4 321,6 245,8

7 29,0 627,8 -0,1

summ 881,7 -167,1 246,1  
 
Calculation of the shear force in base: 
 
 
 
 

(j) F_x F_y F_z

units [kN] [kN] [kN]

1 -0,4399 7,0063 1,2718

2 0,8817 -0,1671 0,2461

R 6,4036 0,9457 6,9681

summ 6,5 7,1 7,1  
 
The overturning moment in each node is calculated as follows: 
 
 
 

The height zi is equal to the height of the concerning node minus the overturning height. In this case, 
the overturning height is equal to zero.  

mode 1

node M_x(1) M_y(1)

[Nm] [Nm]

2 -6136,4 513,1

4 -6136,4 315,1

5 -7709,0 623,6

7 -15049,9 747,9

mode 2

node M_x(2) M_y(2)

[Nm] [Nm]

2 2791,4 -1895,4

4 2791,4 -60,8

5 -1608,1 -2307,1

7 -3139,2 -145,2  
 
In this case, an extra overturning moment is calculated for the residual load case: 

2, ,(1) 0,94 (5 0 ) 4,7N yM kN m m Nm       

 

,( ) , ,( )k j i k j

i

F F l
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mode R

node M_x(1) M_y(1)

[Nm] [Nm]

2 0,0 -4,7

4 0,0 -6,4

5 0,0 -5,7

7 0,0 -15,2  
 

The letter R stands for the residual mode. 
 
For each mode the sum of the overturning moments are taken, afterwards the results are combined 
with the SRSS method: 
 

(j) M_x M_y

units [kN] [kN]

1 -35,0317 2,1997

2 0,8355 -4,4085

R 0,0000 -32,0180

summ 35,0 32,4  
 
Calculation of the modal displacement: 
 
 
 

mode 1

node ux uy uz

[mm] [mm] [mm]

2 -0,95 11,40 0,03

4 -0,59 11,40 -0,03

5 -0,95 11,77 9,70

7 -0,58 11,77 0,00

mode 2

node ux uy uz

[mm] [mm] [mm]

2 2,60 -3,82 0,00

4 0,08 -3,82 0,00

5 2,59 1,81 1,38

7 0,08 1,81 0,00  
 
To calculate the deformations for mode R, the load cases - generated out of the missing masses - are 
inputted as real load cases on the nodes of the structure. This gives the following table: 
 

, ,( ) ( ) ,( )*i k j j k ju G 
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2. Deformation of nodes

Ux Uy Uz

[mm] [mm] [mm]

N1 LC3 0 0 0

N2 LC3 4,14 4,91 0,03

N3 LC3 0 0 0

N4 LC3 1,46 4,91 0

N5 LC3 4,14 8,25 6,74

N6 LC3 0 0 0

N7 LC3 1,45 8,25 0

Linear calculation, Extreme : Node

Selection : All

Load cases : LC3

Node Case

 
 
The deformations for each mode (namely mode 1, mode 2 and mode R) are combined with the SRSS-
formula: 

summ

node ux uy uz

[mm] [mm] [mm]

2 4,98 12,99 0,04

4 1,58 12,99 0,03

5 4,98 14,48 11,89

7 1,57 14,48 0,00  
 
The same for the modal acceleration: 
 
 
 

mode 1

node ax ay az

[mm/sec2] [mm/sec2] [mm/sec2]

2 -158,6 1897,2 5,3

4 -97,4 1897,2 -4,5

5 -158,4 1957,8 1614,2

7 -97,3 1957,7 0,1

mode 2

node ax ay az

[mm/sec2] [mm/sec2] [mm/sec2]

2 586,0 -863,0 -0,4

4 18,8 -863,0 1,0

5 585,9 408,4 312,1

7 18,9 408,4 0,0  
 
For mode R the constant value of 2000 mm/s^2 is used: 

mode R

node ax ay az

[mm/sec2] [mm/sec2] [mm/sec2]

2 2000,0 2000,0 2000,0

4 2000,0 2000,0 2000,0

5 2000,0 2000,0 2000,0

7 2000,0 2000,0 2000,0  
 

  2

, ,( ) ( ) ( ) ,( )* *i k j j j k ju G
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This gives through the SRSS-method: 

summ

node ax ay az

[mm/sec2] [mm/sec2] [mm/sec2]

2 2090,1 2888,7 2000,0

4 2002,5 2888,7 2000,0

5 2090,1 2828,4 2589,0

7 2002,5 2828,3 2000,0  
 
In the same way as for the ‘missing mass method’ the calculated deformations are put on the structure 
as real load cases. This gives the following internal forces: 
 

Mode 1: 

dx N Vy Vz Mx My Mz

[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]

B1 LC3 0 4,38 -1,35 0,36 0,01 -0,49 3,44

B1 LC3 5 4,38 -1,35 0,36 0,01 1,29 -3,3

B2 LC3 0 -3,73 -1,35 -0,04 0,01 0,12 3,44

B2 LC3 5 -3,73 -1,35 -0,04 0,01 -0,06 -3,3

B3 LC3 0 0,62 -4,32 -0,78 0,28 6,54 18,85

B3 LC3 5 0,62 -4,32 -0,78 0,28 2,65 -2,73

B4 LC3 0 0 0,35 0,08 -4,43 -1,48 -0,4

B4 LC3 3 0 0,35 0,08 -4,43 -1,24 0,63

B5 LC3 0 0 -0,12 -1,19 1,48 2,69 0,35

B5 LC3 6 0 -0,12 -1,19 1,48 -4,43 -0,4

B6 LC3 0 0 -0,12 0,54 1,49 -1,46 0,33

B6 LC3 6 0 -0,12 0,54 1,49 1,78 -0,36

B7 LC3 0 0 0,23 -3,19 -1,4 4,78 -0,35

B7 LC3 3 0 0,23 -3,19 -1,4 -4,8 0,34

Linear calculation, Extreme : Member, System : Principal

Selection : All

Load cases : LC3

Member Case

 
  

Mode 2: 

dx N Vy Vz Mx My Mz

[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]

B1 LC4 0 -0,27 0,46 0,36 -0,15 -0,88 -1,17

B1 LC4 5 -0,27 0,46 0,36 -0,15 0,94 1,15

B2 LC4 0 0,59 0,46 0,01 -0,16 -0,03 -1,17

B2 LC4 5 0,59 0,46 0,01 -0,16 0,04 1,15

B3 LC4 0 -0,08 -0,77 0,49 -2,26 -1,52 3,07

B3 LC4 5 -0,08 -0,77 0,49 -2,26 0,94 -0,76

B4 LC4 0 0 -0,55 -0,08 -0,91 -0,25 -0,12

B4 LC4 3 0 -0,55 -0,08 -0,91 -0,5 -1,78

B5 LC4 0 0 -0,05 -0,33 0,25 1,04 0,2

B5 LC4 6 0 -0,05 -0,33 0,25 -0,91 -0,12

B6 LC4 0 0 -0,13 0,01 0,26 -0,06 0,31

B6 LC4 6 0 -0,13 0,01 0,26 -0,03 -0,48

B7 LC4 0 0 0,06 0,6 -0,1 -0,9 -0,05

B7 LC4 3 0 0,06 0,6 -0,1 0,89 0,14

Linear calculation, Extreme : Member, System : Principal

Selection : All

Load cases : LC4

Member Case

 
 

Mode R: 
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dx N Vy Vz Mx My Mz

[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]

B1 LC3 0 4,232 -0,575 0,824 -0,134 -1,804 1,47

B1 LC3 5 4,232 -0,575 0,824 -0,134 2,314 -1,402

B2 LC3 0 -0,061 -0,574 0,244 -0,144 -0,559 1,47

B2 LC3 5 -0,061 -0,574 0,244 -0,144 0,661 -1,401

B3 LC3 0 2,798 -3,078 5,79 -2,301 -22,431 13,299

B3 LC3 5 2,798 -3,078 5,79 -2,301 6,521 -2,093

B4 LC3 0 -1,406 -1,192 0,005 -4,714 -1,048 0,818

B4 LC3 3 -1,406 -1,192 0,005 -4,714 -1,033 -2,759

B5 LC3 0 0,159 0,242 -1,301 1,048 3,092 -0,632

B5 LC3 6 0,159 0,242 -1,301 1,048 -4,714 0,818

B6 LC3 0 -1,527 0,164 -0,282 1,061 -0,117 -0,525

B6 LC3 6 -1,527 0,164 -0,282 1,061 -1,807 0,457

B7 LC3 0 0,039 -0,478 -1,637 -0,778 2,45 0,766

B7 LC3 3 0,039 -0,478 -1,637 -0,778 -2,461 -0,669

Linear calculation, Extreme : No, System : Principal

Selection : All

Load cases : LC3

Member Case

 
  

Combination via SRSS-method gives: 
dx N Vy Vz Mx My Mz

[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]

B1 LC2 0,00 6,10 1,54 0,97 0,20 2,07 3,92

B1 LC2 5,00 6,10 1,54 0,97 0,20 2,81 3,77

B2 LC2 0,00 3,78 1,54 0,25 0,22 0,57 3,92

B2 LC2 5,00 3,78 1,54 0,25 0,22 0,66 3,77

B3 LC2 0,00 2,87 5,36 5,86 3,24 23,41 23,27

B3 LC2 5,00 2,87 5,36 5,86 3,24 7,10 3,52

B4 LC2 0,00 1,41 1,36 0,11 6,53 1,83 0,92

B4 LC2 3,00 1,41 1,36 0,11 6,53 1,69 3,34

B5 LC2 0,00 0,16 0,27 1,79 1,83 4,23 0,75

B5 LC2 6,00 0,16 0,27 1,79 1,83 6,53 0,92

B6 LC2 0,00 1,53 0,24 0,61 1,85 1,47 0,69

B6 LC2 6,00 1,53 0,24 0,61 1,85 2,54 0,75

B7 LC2 0,00 0,04 0,53 3,64 1,60 5,45 0,84

B7 LC2 3,00 0,04 0,53 3,64 1,60 5,47 0,76

Member Case

 
 

The reactions are: 
 

Mode 1: 

Rx Ry Rz Mx My Mz

[kN] [kN] [kN] [kNm] [kNm] [kNm]

Sn1/N1 LC3 -0,36 -1,35 -4,38 3,44 -0,49 0,01

Sn2/N6 LC3 0,78 -4,32 -0,62 18,85 6,54 0,28

Sn3/N3 LC3 0,04 -1,35 3,73 3,44 0,12 0,01

Load cases : LC3

Support Case

Linear calculation, Extreme : Node

Selection : All

 
  

Mode 2: 

Rx Ry Rz Mx My Mz

[kN] [kN] [kN] [kNm] [kNm] [kNm]

Sn1/N1 LC4 -0,36 0,46 0,27 -1,17 -0,88 -0,15

Sn2/N6 LC4 -0,49 -0,77 0,08 3,07 -1,52 -2,26

Sn3/N3 LC4 -0,01 0,46 -0,59 -1,17 -0,03 -0,16

Selection : All

Load cases : LC4

Support Case

Linear calculation, Extreme : Node

 
  

Mode R: 
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Rx Ry Rz Mx My Mz

[kN] [kN] [kN] [kNm] [kNm] [kNm]

Sn1/N1 LC3 -0,82 -0,575 -4,232 1,47 -1,804 -0,134

Sn2/N6 LC3 -5,79 -3,078 -2,798 13,299 -22,431 -2,301

Sn3/N3 LC3 -0,24 -0,574 0,061 1,47 -0,559 -0,144

Linear calculation, Extreme : Node

Selection : All

Load cases : LC3

Support Case

 
 

Summarized by SRSS: 

Rx Ry Rz Mx My Mz

[kN] [kN] [kN] [kNm] [kNm] [kNm]

Sn1/N1 LC2 0,97 1,54 6,10 3,92 2,07 0,20

Sn2/N6 LC2 5,86 5,36 2,87 23,27 23,41 3,24

Sn3/N3 LC2 0,25 1,54 3,78 3,92 0,57 0,22

Support Case

 
 
 
Note: 

In case of CQC, we don’t assume any correlation with the other modes (i.e. absolute value is added) 
The cut-off frequency is the frequency of the latest modes in the analysis. It is the responsibility of the 
user to select the correct number of modes. This can be done in the Setup > Solver. 

 
 

 


